
                                                     

Mobius Tutorial
AMPLIFIER TYPE
SU-MED640

A low‐noise multi‐electrode array system 
for in vitro electrophysiology



Information in this document is subject to change without 
notice.No part of this document may be reproduced or 
transmitted without the expressed written permission of Alpha 
MED Scientific Inc.

While every precaution has been taken in the preparation of this 
document, the publisher and the authors assume no 
responsibility for errors or omissions, or for damages resulting 
from the use of information contained in this document or from 
the use of programs and source code that may accompany it. In 
no event shall the publisher and the author be liable for any loss 
of profit or any other commercial damage caused or alleged to 
have been caused directly or indirectly by this document.

©2012 Alpha MED Scientific Inc. All rights reserved

Version: 1.20; January 1, 2012

Alpha MED Scientific Inc.
Saito Bio-Incubator 209, 7-7-15, Saito-asagi, 
Ibaraki, Osaka 567-0085, Japan
E-mail: support@med64.com
Website: http://www.med64.com



                 Mobius Tutorial (SU-MED640)                                                                         i

Contents

Chapter 1 Introduction
1-1. What is MED64 Mobius? ..............................................1

1-2. Important notice for the MED64 Mobius ........................4
       
       General ....................................................................4
       Acquire MED64 Data w/Stim........................................5
       Replay Raw Data File...................................................5
       Extract Spikes / Extract Long Spikes .............................5
       Filter Raw Data......................................................... 6
       Compute Measure Averages .......................................6

1-3. Activation .................................................................6

1-4. Getting started ..........................................................7
       
       1-4.1. Building up your own Workflow using
                 Mobius Editor...................................................7
       1-4.2. Running workflow.............................................10
       1-4.3. Starting with Workflow Templates.......................11



Contents

ii                        Mobius Tutorial (SU-MED640)

Chapter 2 fEPSPs Recording

2-1. Recording of fEPSPs .................................................13

       2-1.1. Overview of the “Single_pulse_recording” 
                 workflow template..........................................14
       2-1.2. Overview of the [Acquire MED64 Data w/Stim] 
                  module ........................................................15
       2-1.3. Running Workflow ..........................................18
       2-1.4. Before starting your experiment .......................18
       2-1.5. Recording of fEPSPs with single pulse stimulation.19

2-2. Long Term Potentiation (LTP) .....................................23

       1. Selecting the stimulation channels.......................... 23
       2. Input/Output (I/O) curve ......................................23
       3. Making LTP workflow ............................................24
       4. Making a workflow for LTP conditioning stimulus 
           (e.g. Theta burst) ................................................26
       5. LTP experiment.................................................... 27

2-3. Drug testing............................................................28

2-4. Replay and Analysis of acquired data ..........................32

        2-4.1. Replaying acquired data..................................32
       
        2-4.2. Overview of the “Single_pulse_ analysis” 
                  workflow template.........................................34
       
        2-4.3. Analysis of fEPSP signals ................................35
       
        2-4.4. Computing averages according to phases..........38
       
        2-4.5. Data output ..................................................40
                  1. Export raw data.........................................40
                  2. Save the measurement chart ......................40
                  3. Save the average chart...............................41



            Mobius Tutorial (SU-MED640)                                                                               iii

Contents

Chapter 3 Spike Sorter

3-1. Recording of spontaneous neuronal spikes
       (single unit) ............................................................43

       3-1.1. Setting the acquisition parameters....................44
       3-1.2. Execution button ............................................45
       3-1.3. Before starting your experiment .......................45
       3-1.4. Recording without on-line (real-time) analysis ....46
       3-1.5. Recording with extracting spikes and 
                their frequency analysis....................................49
       3-1.6. Recording with on-line (real-time) spike sorting..53

3-2. Drug testing............................................................57

3-3. Replay and Analysis of acquired data ..........................61

       3-3.1. Replaying acquired data ..................................61
     
       3-3.2. Analyzing the spike rate ..................................63
                 1. Set the filter menu..................................... 64
                 2. Set the thresholds.......................................65
                 3.Set the parameters for computing spike
                    frequency....................................................66
                 4. Modify the charts in the 
                     [Display Spike Measure]...............................66
                 Data Output ..................................................68
     
       3-3.3. Computing spike frequency averages according to
                  phase -Making the dose-response-curve-..........71
     
       3-3.4. Spike sorting (clustering) ................................73
                 1. Select the filter menu..................................74
                 2. Set the thresholds ......................................75
                 3. Set the menu for spike sorting (clustering) ....76
                 4. Display Spike Measure charts .......................77
                 5. Compute spike frequencies ..........................77
                 Data output...................................................79



Contents

iv                        Mobius Tutorial (SU-MED640)

Chapter 4            Mobius QT

4-1. Recording of spontaneous myocardial signals.................83

          4-1.1. Overview of the recording workflow templates....84
                     “QT_recording” workflow template...................84
                     “Beat_recording” workflow template................86
                     “Simple_recording” workflow template.............86
           4-1.2. Setting the acquisition parameters...................88
           4-1.3. Execution button...........................................89
           4-1.4. Before starting your experiment......................89
           4-1.5. Recording spontaneous cardiomyocyte signals...90

4-2. Drug testing...............................................................92

4-3. Replay and analysis of acquired spontaneous data...........94
 
           4-3.1. Replaying acquired data.................................94
 
           4-3.2. Overview of the analysis workflow template......96

                     “QT_analysis” workflow template.....................96
                     “Beat_frequency_analysis” workflow template...98
                     “Export_for_propagation_analysis_spontaneous”
                      workflow template.......................................100
 
          4-3.3. Field potential duration analysis......................102

                     Other available Measures for analyzing 
                       field potential duration...............................105
                     [Extract Spike Measures] module..................106

           4-3.4. Beat frequency analysis...............................109



            Mobius Tutorial (SU-MED640)                                                                               v

Contents

           4-3.5. Making a dose-response-curve......................111

                     Case1: How to make a dose-response-curve 
                                of the acquired data with phase bars...111
                     Case2: How to make a dose-response-curve 
                                with acquired data using 
                                 “QT_analysis” workflow template.......113

           4-3.6. Propagation analysis for spontaneous data.......114

           4-3.7. Data output................................................117
                     1. Export raw data.......................................118
                     2. Save the measurement chart.....................118

3. Save the beat frequency data.....................118
4. Save the inter-spike-interval data...............119
5. Save the average chart.............................119

4-4. Recording of evoked myocardial signals........................120

4-4.1. Overview of the “Pacing_recording” workflow
                    template.....................................................120

4-4.2. Setting the acquisition and stimulation 
                    parameters..................................................122

4-4.3. Execution button..........................................124
4-4.4. Before starting your experiment.....................124
4-4.5. Recording of evoked cardiomyocyte sitnals......125

4-5. Replay and analysis of acquired evoked potential data...126

          4-5.1. Replaying acquired data.................................126
 
          4-5.2. Analysis of evoked potential data.....................128
                   Overview of the “Pacing_analysis” workflow 
                    template......................................................128
                   Waveform analysis of evoked cardiomyocyte 
                    signals........................................................129
                   Measurement chart output..............................130
                   Propagation analysis for evoked potential data...132



Contents

vi                        Mobius Tutorial (SU-MED640)



                                                 Mobius Tutorial (SU-MED640): Cahper 1-Introducion                                       1 

1-1. What is MED64 Mobius?

Chapter 1         Introduction

1-1. What is MED64 Mobius?

MED64 Mobius is the data acquisition and analysis software for the MED64 system. It allows MED64 
users to acquire signals at 64 channels and analyze on-line (during recording) and off-line (after 
recording). Mobius consists of various modules, which correspond to task-specific control panels. You 
can design your own experimental protocol as your own "Workflow" by combining these modules using 
Mobius Editor, and then run those workflows both for recording and analysis. Pre-defined workflow tem-
plates are available so that you can run standard types of experiments immediately or design your own 
workflow easily by modifying them.

The goal of this Mobius Tutorial is that you have a quick, smooth start working. Please refer to Mobius' 
on-line Help for detailed information about the software.

The following chart shows all the modules and their brief explanations. You can see which modules are 
included in the package you purchased.

Representative Mobius packages

1. Basic (MED-MS64MR10)
2. EPSP (MED-MS64MR11)
3. Spike Sorter (MED-MS64MR12)
4. Spike Sorter with stim (MED-MS64MR13)
5. Pro (MED-MS64MR14)
6. QT   (MED-MS64MR21)
7. QT with Stim  (MED-MS64MR22)
8. Extended  (MED-MS64MR02)



2                                     Mobius Tutorial (SU-MED640): Cahper 1-Introduction

1-1. What is MED64 Mobius?

Modules Module description

Acquire MED64 Data Set acquisition parameters and acquires spontaneous activities

Acquire MED64 Data w/Stim Programs stimulation protocols and  acquires evoked responses

Replay Raw Data File Replays previously acquired data

Display All Channels Displays data at all 64 channels

Display Single Channel Displays data at a selected single channel

Export Raw Data Exports the raw data to a binary or ASCII file

Extract EP Measures Extracts evoked responses, computes and plots various waveform analysis 
(amplitude, slope, time. etc.) 

Save Measures Data Saves data measured with Extract EP (or Spike Measures) as a “csv” file

Compute Measure Averages Computes measure averages and standard deviations for all experimental 
phases and plots the data

Save Measure Averages Saves the Compute Measure Averages data as a “csv” file

Extract Spikes Detects and extracts the spikes which cross pre-determined thresholds

Cluster Spikes Clusters the extracted spikes

Compute Spike Freqs Builds a time chart of spike frequencies

Display Spike Measures Displays the process of detecting spikes,  extracted spikes waveforms, and 
spike time charts

Save Spikes Saves extracted spikes / Time stamp as a “csv” file

Save Spike Freqs Saves  the spike frequency data as a “csv” file

Extract Long Spikes Detects and extracts the long spikes (>50ms) crossing pre-determined 
thresholds

Display Extracted Spikes Displays the process of detecting spikes and extracted spikes waveforms

Compute Beats per Minute Computes beats per minute

Display Beats per Minute Graphs the beats per minute

Save Beats per Minute Saves the computed beats per minute as a “csv” file

Compute Interspike Intervals Builds a time chart of Inter-spike intervals (the time between each successive 
spikes)

Display Interspike Intervals Displays the graph of Interspike Intervals

Save Interspike Intervals Saves the computed inter spike intervals as a  “csv” file

Extract Spike Measures Computes and plots various extracted spike waveform analysis (amplitude, 
slope, time, etc) of extracted spikes

Display Results Table Displays cumulative results from Extracted EP (Spike) Measures and Compute 
Measure Averages in a table

Filter Spike Data Filters extracted spikes

Filter Raw Data Filters raw data
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   Notice) Acquire MED64R2 Data/Acquire MED64R2 Data w/Stim are for MED-A64MD1 amplifier.
            

Modules / Package Basic EPSP
Spike 
Sorter

Spike 
sorter 
w/stim

Pro QT QT 
w/stim

Extend
ed

Acquire MED64 Data * * * * * * * *

Acquire MED64 Data  w/Stim * * * * *

Replay Raw Data File * * * * * * * *

Display All Channels * * * * * * * *

Display Single Channel * * * * * * * *

Export Raw Data * * * * * * * *

Extract EP Measures * * * *

Save Measures Data * * * * *

Compute Measure Averages * * * * * * *

Save Measure Averages * * * * * * *

Extract Spikes * * * *

Cluster Spikes * * * *

Compute Spike Freqs * * * *

Display Spike Measures * * * *

Save Spikes * * * * * *

Save Spike Freqs * * * *

Extract Long Spikes * * *

Display Extracted Spikes * * *

Compute Beats per Minute * * *

Display Beats per Minute * * *

Save Beats per Minute * * *

Compute Interspike Intervals * * *

Display Interspike Intervals * * *

Save Interspike Intervals * * *

Extract Spike Measures * * *

Display Results Table * * *

Filter Spike Data * * *

Filter Raw Data * * * *
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1-2. Important notice for the MED64 Mobius

Please read and follow the instructions below particularly during data acquisition.

General

• Make sure that your MED64PC's C drive has at least 50% free space.

• Make sure that the hard drive has enough free space when you start a long-term recording.
Recording with all 64 channels for 1 hour creates a 9.216GB data file.
(9.216GB is represented as 9,000,000KB, 8,739.06MB, or 8.58GB in the Windows.)

• Avoid saving data to the drive where the OS is installed (usually C drive). Save it to a separate hard 
drive in the following cases:

  1)  When trace duration is set to longer than 30 minutes. 
  2)  When trace duration is set to longer than 5 minutes and # Traces is greater than 12.

• When Mobius is run for the first time after turning on your MED64 PC, it will take some time for the 
baseline to appear and stabilize at 0 V at all 64 channels. Run Mobius using the "Noise check" 
workflow until the baseline trace stabilizes before you start your experiment.

• Particularly, do NOT start with workflows that include the "Extract spikes" or "Extract long spikes" 
modules. These may cause Mobius to crash.

• When a display monitor with a resolution of 1920 x 1080 is used, set the Windows 7 text size 
([Control Panel] > [Appearance and Personalization] > [Display]) to “Smaller” (100%). Otherwise, 
some modules are not displayed correctly.

Fig.1-2.1.Baseline traces before stabilizing (left) and stabilized baselines (right).



                                                 Mobius Tutorial (SU-MED640): Cahper 1-Introducion                                       5 

1-2. Important notice for the MED64 Mobius

• Set the “Decimal symbol” to “period” (.). Mobius does not 
work properly with the “comma” (,) setting for the decimal 
symbol. Go to [Control panel] > [Clock, Language, and 
Regions]. Open the [Format], and change the “Decimal 
symbol” to “period” (.). Or. select “English (US)” for the 
“Language”. 

Acquire MED64 Data w/Stim 

• The F-channel stimulation does NOT support the decimal number places.The smallest increment 
possible with the F stimulator is 1 A and 0.1 A with the V stimulator.

        
• The maximum number of pulses for a [Step] in the "Stimulus waveform editor" (#12 in the Fig. 

2-1.4, page 15) is 21.  

Replay Raw Data

• Opening a large data file can take several minutes. (e.g. Opening a 10GB file takes over 1 minute.)

 

Extract Spikes / Extract Long Spikes

• These modules require powerful computation and need to be used carefully during acquisition. 
Mobius can appear to freeze when it extracts more spikes than it can analyze. This most often hap-
pens when non-biological signals cross the spike extraction thresholds on all channels at once. (e.g. 
unexpected noises cross the thresholds or the baseline fluctuates due to vibration.) Please keep in 
mind the following instructions when these workflows are used with acquisition.

• Avoid using these modules on-line (during signal acquisition) until you are familiar with your 
experiment(s) and biological assay(s). Particularly avoid using these modules for long-term 
recordings.

• Set the trace duration to less than 10 minutes and the trace interval for longer than the trace 
duration so that the extracting spikes can catch up with acquisition during the trace interval. 

• For recording neuronal spikes, make sure to set the low-cut filter to 100 Hz in order to remove 
low-frequency noise.

• Make sure to PAUSE Mobius when drugs are applied.

• Minimize the number of recording channels.

Fig.1-2.2. Selecting. (period) for the
 “Decimal symbol”.
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Filter Raw Data

• Mobius acquires data in 500 msec blocks. Digital filtering can cause small noise spikes to appear at 
the end of a data block if the baseline is offset from 0 at the end of the data blocks. To eliminate 
this noise:

• While recording neuronal spikes, set the Low-cut filter to 100 Hz.
 

• While recording cardiac signals (low-frequency), avoid using the "Filter Raw Data" module. 
Instead, use "Filter Spike Data" so that the extracted beating signals (long spikes) are filtered.

Compute Measure Averages

• Since this module is always at the end of the analysis chain, it can slow down the display of incom-
ing data. Thus, it is not recommended to use this module during acquisition. When it is used during 
acquisition:

• Set the trace duration shorter than 10 minutes while the trace intervals for longer than the 
trace duration.

• Minimize the number of recording channels.

1-3. Activation

Mobius needs to be activated with your key-file.

1. Save the key-file in the [Program file] > [WitWerx] >[Mobius] folder.
2. Open Mobius. Click [Help] > [Activation].
3. You will see your Hardware serial # in the box. Click the box next to the Keyfile box to select your 

key-file.
4. Click OK for activation.

      

Fig.1-3. Activating Mobius.
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1-4. Getting started

When Mobius is opened, there is no "Workflow". You must create and run your own "Workflows" for 
acquisition and analysis. You can create your Workflow by:

1. Building your own workflow using Mobius Editor.
2. Using the pre-defined workflow templates.

In this chapter, you will learn briefly how to use Mobius Editor to design your own workflow. The follow-
ing chapters will instruct you how to start your experiments using some of workflow templates.

1-4.1. Building up your own workflow using Mobius Editor

This section will quickly introduce you how to use Mobius Editor.

1. Open Mobius. Select the [Workflow] > [New] > [Blank] to open 
the “Mobius Editor” window.

2. This window shows a library of available task 
modules (task specific panels) on its right 
panel. Click on a module to see its description 
at the bottom of the screen.

A workflow is created by building a list of 
task-specific modules on the left panel of the 
Editor. When a module is double-clicked, it is 
shifted to the left panel and the task-panel for 
the module appears on the screen.

For acquisition, start by double clicking either 
the [Acquire MED64 Data] or the [Acquire 
MED64 Data w/Stim] module. For replaying or 
analyzing the acquired data, start with [Replay 
Raw Data File]. Other modules for display and 
analysis can follow either of these modules.

• [Acquire MED64R2 Data] and [Acquire 
MED64R2 Data w/Stim] are acquisition modules for the MED-A64MD1 amplifier. It can NOT be 
selected for your amplifier (SU-MED640).

Fig.1-4.3 shows the designed acquisition workflow (top-left), its Editor (middle), and the workflow 
structure (bottom).

Fig.1-4.1. Opening the Editor.

Fig.1-4.2. Mobius Editor. 
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3. You will see arrows next to the modules on the left. Their meanings are described below;

• Gray right pointing arrows: The modules with these arrows can be used AFTER the selected 
module (highlighted in dark blue) in the Workflow list. Double-clicking a module with this 
arrow next to it will insert it AFTER the selected module in the workflow.

• Green right pointing arrows: The modules with these arrows can be used AFTER the selected 
module (highlighted in dark blue).

• Light blue downward pointing arrows: The modules with these arrows can be used BEFORE the 
selected module (highlighted in dark blue).

• Gray downward pointing arrows: When these arrows appear next to a module name, they indi-
cate that the output of this module can satisfy the input prerequisites of the currently selected 
module (highlighted in dark blue) in the Workflow list. Double clicking one of these will insert 
it BEFORE the selected step in the workflow.

• Red steps: You may notice that some of module names are written in red text. This means that 
the step does not meet input prerequisites. Select the red step (click on it once) to see which 
modules can satisfy its needs (the ones with gray downward arrows next to them) and select 
the appropriate one to add to the Workflow box (double-click them). Or, right-click the red 
step and select [Delete] to remove this module from the Workflow box.

Fig.1-4.3. An example of a designed acquisition workflow. The modules
on the Workflow box (left box) are now on the screen. 
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4. In many cases, you can not have all the desired control panels on 
a Tab (screen). You can create new tabs by selecting [Layout] >  
[Add Tab], then type a name for the new Tab. (Fig.1-4.4)

5. In order to have control panels on the new tab, 1) open the new 
tab by clicking the tab name, and 2) open the Mobius editor and 
edit modules on the new tab. You can go back and forth between 
these tabs during your experiments.

The Fig.1-4.5 shows analysis and export modules are added to the 
workflow on a new Tab.

Fig.1-4.4. Creating a new tab.

Main tab

Analysis tab

Fig.1-4.5. An example of a workflow design. A new tab (Analysis) is created, then analysis and saving modules
  

are added to this tab. The bottom chart shows the configuration of this workflow.
                      

Acquire MED64 Data w/Stim

Display 
All Channels

Export 
Raw Data Extract EP Measures

Compute Measure Averages Save Measures Data

Save Measure Averages
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6. Save it as your own Workflow. (Select [Workflow] > 
[Save as]). Now you are ready to do an experiment.

7. Acquisition with saving data starts by clicking 
GREEN-RED button.

Running a recording workflow by clicking the 
Green-Red button generates following files automati-
cally at the same folder where the recording workflow 
(.moflo) file is saved;

• Data file (.modat)
• Analysis workflow file(.moflo) including analysis modules you selected for your recording 
• Acquisition workflow file (.moflo) 

1-4.2. Running workflow

1. Your workflow can be opened by selecting [Workflow] > [Open].

2. You can run and stop your workflow with the Execution Buttons.

Fig.1-4.6.

Data file (.modat)

Acquisition workflow file (.moflo)
saved automatically

Analysis workflow file (.moflo)
saved automatically

Acquisition workflow file (.moflo) 
you made

Fig.1-4.7. Data and Workflow files generated in a folder after recording 
(running workflow with Green-Red button).

Fig.1-4.8.

           

          Stop                 Run WITHOUT        Run WITH              Pause
                                Saving data/ or

Exporting

Saving data / or
Exporting

                        Fig.1-4.9.
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1-4.3. Starting with Workflow Templates

The easiest way to get started with Mobius is to use the predefined workflow templates. You can start 
your experiments using these workflow templates right away or design your own workflow by editing 
these templates. The following chapters will instruct you on how to start your experiment using these 
workflow templates.

1. Click [Workflow] > [New] > [Templates]. Select [SU-MED640_1280x1024] folder, and then select 
desired template. 

2. You can change parameters and save the template as your own workflow to go directly to your 
experiment

3. Or, modify the templates with Mobius Editor. Select [Workflow] > [Edit] to open the Mobius Editor. 

Templates

Noise_check

Spontaneous_recording

Evoked_recording

Single_pulse_recording

Paired_pulse_recording

Theta_burst

LTD_conditioning

I-O_curve

Single_pulse_analysis

Paired_pulse_analysis

Spike_recording

Spike_recording_cluster

Spike_recording_filter

Spike_recording_filter_cluster

Spike_recording_stim

Spike_recording_stim_cluster

Spike_recording_stim_filter_cluster

Spike_frequency_analysis

Spike_frequency_analysis_filter

Spike_sorting

Spike_sorting_filter

Beat_recording

QT_recording

Simple_recording

Beat_frequency_analysis

QT_analysis

Export_for_propagation_analysis_spontaneous

Pacing_recording Pacing_recording

Pacing_analysis Pacing_analysis

Folders

Basic_recording

Spontaneous_recording

Spontaneous_recording

EPs

Spike_ recording_and_stimulation

Sponaneous_analysis

EP_analysis

EP_recording

Spikes

QT

Spike_analysis

Fig.1-4.10. Available workflow templates.



12                                     Mobius Tutorial (SU-MED640): Cahper 1-Introduction

1-4. Getting started



                                        Mobius Tutorial (SU-MED640): Cahper 2 - fEPSPs Recording                                               13 

2-1. Recording of fEPSPs

   

Chapter 2         fEPSPs Recording

This chapter describes how to record and analyze fEPSPs using Mobius workflow templates. In this 
chapter, you will learn about

1. Recording fEPSPs from hippocampal acute slices
2. Long Term Potentiation (LTP)
3. Drug testing 
4. Replay and analysis of the acquired data 

2-1. Recording of fEPSPs

The goal of this section is that you be able to record fEPSP signals while measuring their amplitude and 
slope using "Single_ pulse_recording” workflow template.

1.Open the "Single_pulse_recording" workflow template. 

1) Click [Workflow] > [New] >[From Tem-
plate]. Select [SU-MED640_1280x1024] 
folder.

2) Select [EPs] > [EP_recording] folders. 
Select the “Single_pulse_recording” work-
flow template.

Fig.2-1.1. Opening workflow template.
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2-1.1. Overview of the “Single_ pulse_recording” workflow template

The "Single_ pulse_recording" workflow template consists of the following modules located in the 
“Main” and “EPSP measures” Tabs.

Evoked signals are acquired with the [Acquire MED64 Data w/Stim] module. The acquired signals are 
sent to the [Extract EP Measures] module, where several types of amplitude, slope, and time are mea-
sured and graphed. Raw data can be exported to binary or ASCII ("CSV" formatted text file).The mea-
surement chart can be saved as a "CSV" formatted text file.

Fig.2-1.2. Module configuration for the “Single_pulse_recording” workflow template.

Fig.2-1.3. “Single_pulse_recording” workflow template. “Main” tab (left), “EPSP measures” tab (right).

Tab Modules

Main Acquire MED64 Data w/Stim  / Display All Channels  / Export Raw Data

EPSP measures Extract EP Measures  (2) / Save Meausres  Data (2)

“Main” Tab 

“EPSP 
measures” Tab

Acquire MED64 Data w/Stim

Display 
All Channels

Extract EP Measures

Save 
Measures Data

Export 
Raw data

Extract EP Measures

Save 
Measures Data

   Export Raw Data

Display All Channels

Save Measures Data

 Extract EP Measures

Acquire MED64 Data w/Stim
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2-1.2. Overview of the [Acquire MED64 Data w/Stim] module

The acquisition and stimulation parameters are set in this module. 

Acquisition

1. # Traces: Number of Traces (Sweeps).

2. Trace duration: Sampling (Recording) time for each trace.

3. Trace interval: 
Interval between traces. (From the beginning of the first trace to the beginning of the next trace)

4. Range (V): 
Maximum input signals level. This setting should be adjusted according to the signal amplitude to 
achieve the maximal dynamic range. 

5. Low cut freq (Hz):
High pass filter. Select 0.1 Hz, 1.0 Hz, 10 Hz, or 100 Hz. If 1.0 Hz is selected, signals with frequen-
cies lower than 1 Hz are filtered out. Usually, 1.0 Hz is recommended for recording of fEPSP.

6. Channels:
Select the channels for recording here. When the square box is clicked, the channel selector pops 
up. The enabled recording channels are colored green.

7. Save raw data:
When Mobius is started by clicking the Green-Red recording button while the [Enable storage] is 
checked, the raw data is saved. Enter a descriptive file name of your choice.

(1)

(2)

(3)

(4) (5)

(6)

(7)

(8)
(9)

(10)

(10)

(11) (12) (14) (15)(13)

Fig.2-1.4. [Acquire MED64 Data w/Stim] module.

                      

The botom shows the stimulus parameters for the
Step 2.
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Stimulation 

Each Step is independent and can be programmed with different types of stimulation protocols. Enabled 
steps will be applied in order (1 to 8) at the intervals set in the Trace Interval.

8. “Step enabled” check box:
When the box to the left of [Step enabled] is checked, the Step becomes valid. The default settings 
have Step1 and Step 2 enabled, and Steps 3-8 disabled (shown with # next to each Step). Step1 
and Step 2 are applied alternately at 20 second intervals.

9. Stimulator selector and check box:
Select the MED64 amplifier’s built-in stimulator (F1, F2, F3, or f4) here. F1 corresponds to [INT. F1] 
on the MED64 integrated amplifier while F2 corresponds to [INT. F2]. Checking the box on the right 
of “Stimulator Enabled” activates the selected stimulator. The default settings have F1 enabled for 
Step 1 and F2 for Step 2. Stimulation is applied through F1 and F2 alternatively 20 second inter-
vals.

 F1 and F2 can be enabled at the same Step to stimulate 2 channels simultaneously.

10. Stimulus waveform editor:
Make your stimulus protocol here by selecting either [Const] or [Pulse] and typing in the desired 
Length and Amplitude. Refer to Fig.2-1.5 for a schematic representation of a stimulus protocol 
example.

• The F1 and F2 channels do NOT support the numbers of decimals. The smallest current incre-
ment possible with the F stimulator is 1 A and 0.1 A with the V stimulator. 

• Do NOT select [Ramp] for the stimulation with the MED64.Only bi-phasic stimulation is recom-
mended.        

11. Repeat pattern to trace end check box:
When this box is checked, the stimulus protocol programed at the Stimulus waveform editor (12) 
will be repeated to the end of the trace. Useful for LTD conditioning.

 post stimulation time: 94.80 msec

 pre stimulation time: 5 msec

c

0.2 ms

Fig.2-1.5. Example of a stimulus protocol and its
    schematic diagram.         

-10A
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12. Reps selector:
The stimulus protocol set at the “Stimulus waveform editor” (10) will be repeated the number of 
times set here. Useful for multiple pulse stimulation such as LTP conditioning.
• Repeat of the stimulus waveforms which durations are longer than 1 minute is not recom-

mended.

13. Stimulus current amplitude increment button:
When the + button is clicked, the absolute value of the stimulus current amplitude for the [Pulse] is 
incremented by the value set it the left box. (14*) For example, if 2 is set in the box (14) and the + 
button is clicked once, the stimulus amplitude will be changed to -12.00 A from -10.00 A. This is 
useful for changing the stimulus amplitude for multiple pulse stimulations (e.g. Theta burst) with 
just one click. The absolute value of the stimulus amplitude can be decreased sequentially using the 
same procedure when - button is clicked.

14. See #15

15. Auto Inc check box:
When this box is checked, the stimulus current amplitude will automatically increase adding the 
value (in  A) set in the left box (14) to each preceding stimulation pulse. This is useful for making 
I/O curves. Please refer to section 2-2.3.Input/Output curve (page 23) for details.

In the default setting, Step1 (F1) and Step 2(F2) run alternating every 20 seconds in this workflow.

2-1.3. Running workflow

The workflow is run and stopped (paused) with the execution buttons.

Fig.2-1.6. Execution buttons.

           

          Stop                 Run WITHOUT        Run WITH        Pause
                               saving data             saving data 
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2-1.4. Before starting your experiment

When Mobius is run with Green or Green-Red button for the first time after turning on your MED64PC, it 
will take some time for signals to appear on the screen and stabilize to the isoelectric baseline at all 64 
channels. Before you start your experiment, change the [Trace Interval] to around 1-2 seconds tempo-
rarily and run several traces for a few minutes (WITHOUT the stimulus cables plugged in) until the 
baselines at all 64 channels stabilize around 0 V. After you see this, you can stop Mobius and start your 
experiment.

 

and stabilized  baseline (left-bottom). The trace interval
Fig.2-1.7. Baseline traces before stabilizing(left-top) 

 

changed to 1 sec. (right-top)
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2-1.5. Recording fEPSPs with single pulse stimulation

Now you will set the parameters for single pulse stimulation at a single channel and record fEPSPs. 

1. [Step1] and [Step2] are enabled in the "Single_pulse_recording" workflow template. Disable 
[Step2] so that stimulation is applied only through the channel selected in the [Step1].

1)   Click the [Step2] tab and uncheck [Step enabled].

2)   You will see that the # mark appears next to [Step2], indicating that this Step is disabled.
      (Refer to Fig.2-1.8)

  Fig.2-1.8. Disabling [Step2].

2. Click on the tab for [Step1] so that parameters for the Step1 appear.

How do I change the stimulator at a given Step?

F1 is enabled for Step 1 in the default settings. if you would like to use another stimulator (for 
example, V1 instead of F1, change the stimulator following the procedure below: 

1)   Uncheck [Stimulator enabled] for F1 by clicking the check box.

2)   Select V1 at the stimulator selector and check [Stimulator Enabled] for V1. Now V1 stimulator 
is enabled instead of F1 (Fig.2-1.9)

• Check both F1 and V1 to stimulate through 2 channels simultaneously.

        

1)

Uncheck the F1 stimulator (left), then check

V1 stimulator (bottom)

Fig.2-1.9. Changing the stimulator to V1 from F1.
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3. Connect a stimulation cable to INT. F1 and any channel at the CHANNEL SELECTOR on the MED64 
amplifier. 

4. Start Mobius with the Green button (Run WITHOUT saving data). Find the best channel for stimula-
tion by looking at the 64 channel display and changing the stimulation channel by plugging the 
stimulation cable in and out of the amplifier’s CHANNEL SELECTOR. You can also change the ampli-
tude during this procedure for optimal stimulation.

5. When you find the optimal stimulation channel and amplitude, set the protocol for on-line analysis 
as follows: (Refer to Fig.2-1.10)

1)   Open the "EPSP measures” tab.

2)   Set the [Step Filter] to Step1 for both measures.

3)   Select the channels you want to monitor analysis on-line during your recording.
• Channels can be changed even during recording (or running) by scrolling or typing the num-

bers directly.

        
4)    The default settings have "Slope 1040 LinerFit” (red cursor) and “Amplitude Minimum” (blue 
cursor) selected for measurement. Change the measurement menu if necessary. (Refer to 
Fig.2-1.11)

• Mobius must be stopped to change the measurements.
• Analysis can be done later off-line.

3)
2) 4)-(1) Click this button

   to Edit measurements

Fig.2.1-10. fEPSP measurements.
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(1) Click [Edit Measures], and then select the measurement (analysis) you want at the [Measure 
Type] column. (The name can be customized by typing it directly into the [Custom Name] 
column.)
•    Please click [Measures Help] for detailed explanations for the measurements.

(2) Click [Add Measures] to perform more analysis. 

(3) To delete a measurement, right click the custom name and select the [Delete].

(4) Close this editor by clicking the [Hide] button.

 

           

5)    Set the cursors by clicking on them and dragging them to the desired position.    

•  For detailed information on analysis, please refer to section2-4.3. Analysis of fEPSP signals on 
page 35.

      How do I adjust the graph scale to zoom in on the waveforms?

1) Left-clicking and dragging while pressing the shift button. 

2) Changing the maximum (and/or minimum) numbers for both X (time) and Y (amplitude) axis.
    Click, then, type in the new value(s) for the maximum and/or minimum.

•  Double-clicking anywhere on the chart to return to the original axis range.

6. Make sure that “Enable storage” is checked in the [Save Raw Data] (“Main” tab) to save the data. 
(The file name can be modified.) Set the # of traces. 

(3)

(2)

(1)

(4)

Fig.2-1.11. Edit measurements.
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7. Save this workflow as your Recording Workflow by clicking 
[Workflow] > [Save As]. (Fig.2-1.13)

8. Start Mobius with the GREEN-RED button. 

•  Mobius will require you to save the workflow as your 
own if you try to start Mobius with the Green-Red 
button without having saved it already.

• The data file (.modat file) and analysis workflow 
including all analysis modules selected for the 
recording workflow (.moflo file) and [Replay Raw 
Data] module will be saved in the same folder.

                (Refer to Fig.1-4.7 on page 10 for files generated after recording.)

Fig.2-1.12. Workflow for single pulse recording stimulating at 1 channel. Only the F1 stimulator is enabled for 

bl d f [ ] [ ] d bl d
[Step1]. [Step2] is diabled.

Fig.2-1.13.
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2-2. Long Term Potentiation (LTP) 

This section describes how to perform an LTP experiment. This method involves recording baseline 
activity and LTP with one workflow, whereas conditioning stimuli is applied with another. The following 
procedures are detailed in this chapter.

1. Selecting the stimulation channels for experimental and control pathways.  
2. Identifying the appropriate stimulus current amplitude for both pathways with an I/O curve.
3. Making the LTP workflow.
4. Making Theta burst workflow.
5. Recording LTP.

1. Selecting the stimulation channels

Open the "Single_pulse_recording" workflow template. Determine the 2 different stimulation channels 
for experimental pathway and control pathways, and the desired channel for on-line monitoring by run-
ning the workflow without recording using the Green button. (Please refer to section 2-1.5. Recording 
of fEPSPs” on pages 19-22)

2. Input/Output (I/O) curve

This procedure is carried out to determine the appropriate stimulus current amplitude for recording fEP-
SPs. The slope or/and amplitude are usually selected as the output parameters. A current amplitude 
eliciting 30% to 50% of the maximal amplitude is typically selected. For LTP recording, the appropriate 
stimulus amplitudes need to be identified with I/O curves for the control and experimental pathways.

1. Open the “IO_curve” workflow template. In the default setting, (1)-10 A is selected for the initial 
stimulus current amplitude, (2) the [Auto Inc] button is checked, and (3)5A is set for the incre-
ment value. The current amplitude will increase automatically by 5 A in subsequent trace until the 
end of the recording (e.g. 10, 15, 20------. 105 A). 

Modify the stimulus current amplitude, length, and increments depending on your signals and slice 
viability. Change the stimulus channel to that identified for experimental pathway (or control path-
way).

2. Open the “EPSP measures” tab. Change the measurement to analyze if necessary, and then set the 
cursors. (Refer to section 2-4.3. Analysis of fEPSP signals on page 35) Change the channels to 
those you selected for on-line monitoring.

(3)           (2)        (1)Fig.2-2.1. ”IO_curve” workflow template.
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3. Save the workflow as your custom I/O curve workflow. Click the Green-Red button to start the 
recording. (Click on the Green button if you would not like to save data). 

4. Determine the 30% (or 50%) for the maximal (saturating) stimulus amplitude. The following exam-
ple shows a protocol in which the stimulation started at 5 A, and then increased by 5 A in every 
subsequent trace. The responses saturated at the 12th trace (60 A) at approximately -1900 V. 
The 30% and 50% of -1,900 V are 633 V and 950 V respectively. The stimulus current ampli-
tude eliciting 30% of the maximal response is 20 A and the stimulus current amplitude eliciting 
50% of the maximal response is 25 A.

 Fig.2-2.2. Determination of the stimulus current amplitude eliciting 30% and 50% of the maximal response.

5.  Determine the stimulus amplitude for the experimental and control pathways.
• You can do test both pathways simultaneously if Step2 is enabled. In this case, stimulus ampli-

tude increases by 5 A independently for each Step.

6.  After you identify the stimulus current for both pathways, close this workflow. 

3. Making an LTP workflow

In this section, you will learn how to make your LTP workflow using the "Single_pulse_recording" work-
flow template. Both baseline and LTP will be recorded with this workflow. After recording of the base-
line, you will apply theta burst with another workflow, and then come back to this LTP workflow for LTP 
recording.

1. Open the "Single_pulse_recording" workflow template, and modify the experimental parameters. 
Keep in mind the following important points:

1)   # of traces: set the number so that both the Baseline and LTP recordings will run with this 
workflow. For example, inputting 300 for the # of traces and 20 seconds for the trace interval will 
result in a recording 100 minutes long (20 sec x 300 times).

2)   Step 1 stimulation: change the stimulus amplitude to the value identified by the I/O curve for 
the experimental pathway. In Figure 2-2.3, the stimulus amplitude was changed to -20 A. 
Connect INT.F1 and a selected channel on the MED64 amplifier with the stimulation cable. Make 
sure that other stimulus channels besides F1 are NOT enabled in Step1.  

3)   Step 2 stimulation: change the stimulus amplitude to the value identified by the I/O curve for 
the control pathway. In the example, the stimulus amplitude was changed to -25 A. Connect  the 
INT.F2 and a selected channel on the MED64 amplifier with the stimulation cable. Make sure that 
other stimulus channels besides F2 are NOT enabled in Step 2.

4)   Make sure Steps 3-8 are NOT enabled.

Saturation

-1900V

30%, -633V

50%, -950V

5 A 10 A 20 A  25 A  60 A
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• In this example, Step1 (F1) is selected for the experimental pathway through which the theta 
burst will be applied after recording of the baseline. Step2 (F2) is selected for the control 
pathway.

 Fig. 2-2.3. Recording parameters for LTP recording.

2. Open the EPSP measures tab and modify the analysis parameters.

1)  Change the channel to that identified for on-line monitoring in the previous step.

2)  Change the measurements (analysis) as necessary.
• The default settings enable “Slope1040 Liner Fit” and “Amplitude Minimum”.

3)  Run a few traces with the Green button. Once waveforms appear, set the cursors for the 
measurements. 

• Refer to section 2-4.5. Analysis of fEPSP signals on page 35 for detail.

2)

1) 3)

Fig.2-2.4. Running the LTP workflow. 

Step1:
Experimental
Pathway
(Conditioning stimulus 
 will be applied)

Step 2:
Control Pathway 
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3. Save it as your own LTP workflow (Click [Workflow] > [Save as], and type file name) and leave it 
open.

     Fig.2-2.4. Saving the LTP workflow.

4. Making a workflow for LTP conditioning stimulus (e.g. Theta burst)

In an LTP experiment, you will need to apply a conditioning stimulus such as a theta burst to the exper-
imental pathway right after recording the baseline activity. The best way to do so is to have the 2 work-
flows, for baseline/LTP recording and conditioning stimulus, open and ready on your MED64 PC. In this 
section, you will make a workflow for the theta burst stimulation using the workflow template.

1. Open the “Theta_burst” workflow template. 

2. Change the stimulus amplitude at the [Pulse] to the value determined for the experimental path-
way. 

• Use the +/- button to change the amplitude. For example, in order to change to -20 A from 
-10 A, select 10 A (Figure.2-2.5, (1)), then click the + button once (Figure.2-2.5, (2))so 
that amplitudes for all 4 "pulses" are changed to -20 A. If you directly type the number at the 
[Pulse] boxes, you must type it in 4 times for all [Pulse] boxes. 

3. Make sure steps 2-8 are NOT enabled

4. Make sure other stimulators besides F2 are NOT enabled at Step1.

5. Save as your own Theta Burst workflow

  Fig.2-2.5. Example of a theta burst conditioning stimulus protocol.

6. Leave it open on your MED64 PC.

2) Use this button so that all numbers at Pulses are 

increased (or decreased) at one time.

2

1)
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5. LTP experiment

Now you have 2 workflows (LTP workflow and Theta Burst workflow) open on your MED64 PC, and are 
ready to start recording. 

1. Activate the LTP workflow by clicking the title bar on the LTP workflow. Make sure that [Enable stor-
age] is checked. Make sure that the stimulation cables are connected to the right channels on the 
MED64 amplifier. Start your experiment by clicking the GREEN-RED button. 

2. After you finish recording baseline activity, PAUSE the experiment with the YELLOW button.
DO NOT stop the recording with the Black button. The experiment will be stopped. Baseline and LTP 
data can NOT be stored in the same data file.

3. Quickly activate your theta burst workflow by clicking the title bar on the theta burst workflow. 
Apply the theta burst by clicking the Green button once. (or Green-Red button if you would like to 
save this data.)

4. When the theta burst stimulus protocol is finished, quickly go back to the LTP workflow and restart 
your experiment by clicking the GREEN-RED button. 

Fig.2-2.6. LTP experiment.
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2-3. Drug testing

Mobius' [Compute Measure Averages] module calculates averages and standard deviations for the mea-
surements (waveform analysis) in all experimental phases. This is a useful tool for making a 
dose-response curve or comparing the results from different phases during drug application. This sec-
tion will show you how to make a dose-response curve using this module.

Since this module is at the end of the analysis chain, it can slow down the data processing and causes 
Mobius to stop during your experiment if you perform these analyses online. Thus, it is recommended 
not to use this module during recording unless you are very familiar with your experiment and prepara-
tions. All analyses introduced in this section can be performed later off-line. 

One alternative is just making bars (phase-annotations) at the beginning of phases (e.g. drug1) with-
out on-line analysis. The location of the phase bars are saved to the analysis workflow. To do this, skip 
steps 1-3 and start with step 4. 

1. Open the "Single_pulse_recording" workflow template.

2. Add modules [Compute Measure Averages] and [Save Measure Averages] to this workflow tem-
plate.

1)   Make a new tab. Click [Layout] > [Add Tab], then type in the name for the new tab. (Fig.2-3.1)

2)   Open the Editor in the new tab. (Click [Workflow] > [Edit]) (Fig.2-3.2)    

                                                                                                    

3)   Click the [Extract EP Measures -step1-], on the 
left "Workflow" box, and then double-click the 
[Compute Measure Averages] on the right 
Available task panels. (Fig.2-3.3). 

You will see the [Compute Measure Averages] 
module shift to the left box, under the [Extract 
EP Measures -step1-] (Fig.2-3.4). The panel for 
this module will appear in the new tab.

Fig.2-3.1. Making a new tab. Fig.2-3.2. Editor is opened in the new tab.

Fig.2-3.4.

Fig.2-3.3.
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4) Click the [Compute Measure Averages] module on the left “Workflow” box, then double-click the 
[Save Measure Averages] on the right “Available task panels" so that the [Save Measure Averages] 
module is shifted to the “Workflow” box under the [Compute Measure Averages].

    Averages and standard deviations for the [Extract EP Measures -step1-] (top chart in the EPSP 
measures tab) will be computed and displayed. If online analysis for the other [Extract EP 
Measurement-step2-](bottom chart) is necessary, add the same modules under the [Extract EP 
Measures -step2-].

Fig.2-3.5. Control panels for the [Compute Measure Averages] and [Save Measure Averages] modules (left) and 
the modules in the completed new workflow (right).

3. Open the [Extract EP Measures] module (in the EP measures tab), select measurements for analy-
sis, and set the cursors (refer to section 2-4.5.Analysis of fEPSP signals on page 35).  

4. Save it as your own workflow. 

5. Run Mobius with the GREEN-RED button. The first phase (baseline) will start from time 0.
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6. Pause Mobius with the YELLOW button 
when the first phase or baseline recording 
is completed. Click [Annotations] > [Add 
New Phase]. Type the name for the 2nd 
phase. (e.g. dose 1,Fig.2-3.6)

Do NOT stop with the Black button. If it is 
stopped, the experiment will end and new 
phases will NOT be added.

7. When the OK button is clicked, a yellow 
bar with the chosen name appears on the  
measurement chart. (Fig.2-3.7)

8. Re-start Mobius by clicking the 
GREEN-RED button.

Time in the measurement chart will 
continue running even during the pause.
 

9. Pause Mobius with the YELLOW button 
when the second phase (e.g. dose 1) is 
completed. Click [Annotations] > [Add 
New Phase] again.

10. Type in the name for the 3rd phase. (e.g. dose 2) When the OK button is clicked, the yellow bar 
with the name appears on the measurement chart.

11. Start Mobius again with the GREEN-RED button. Add subsequent phases using the same procedure.

12. You can see the table and graph of averages for each phase on the [Compute Measure averages] 
module (in the “Averages” tab) (Refer to Fig.2-3.8)

•  The phase annotations (yellow bars) can be shifted by clicking and dragging during off-line 
analysis. When data is replayed after the phase annotations are shifted, averages and stan-
dard deviations are computed again based on the new phase annotations location.

Fig.2-3.6. Making a new phase.

Fig.2-3.7. Adding a new phase.
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Input fields in the [Compute Measure Averages] module

1. Channel: Selects the channel to be displayed. The selection cannot be changed during recording.

2. Use last: If this box is checked, the selected (or typed) number of data points are used for compu-
tation. This is mostly for off-line analysis. 

3. Hide: You can hide the measurement which is checked from the chart.

Note: the chart can be zoomed up or down by clicking and changing numbers of the maximum and/or 
minimum scale for both X and Y axis.

Fig.2-3.8. [Extract EP Measures] module with phase bars (top) and [Compute Measure Averages] 
module (bottom).
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2-4. Replay and analysis of acquired data

Mobius data files (.modat) are opened and replayed with the [Replay Raw Data File] module and ana-
lyzed using the [Extract EP measures] module. In order to run and analyze the acquired data, you need 
to create and run an analysis workflow. The quickest way to replay and analyze the acquired fEPSP data 
is using the “Single_pulse_analysis” workflow template (which will be introduced in this chapter).

The analysis workflow including the analysis and saving modules you selected for your recording and 
[Replay Raw Data File] instead of [Acquire MED64 Data w/Stim] are automatically saved to the same 
directory where your recording workflow is saved. (Refer to page 9) The other quick way is to use those 
workflows. The analysis workflow is opened by clicking [Workflow] > [Open] and selecting the workflow 
(.moflo) file.

2-4.1. Replaying acquired data

1. Click [New] > [From Template]. Select [SU-MED640_1280x1024] folder. 
Select [EPs] > [EP_analysis] folders, and then “Single_pulse_analysis” workflow template.

      Fig.2-4.1. Opening the analysis workflow template.

2. Open the acquired data file (.modat) by clicking the box next to the [Filename] and selecting the 
desired file. When the file appears on the Filename box, the data is ready to be replayed by clicking 
the Green button or Green-Red button. (Fig.2-4.2)

3. When the Green button is clicked, the acquired data is just replayed. Clicking the Green-Red button 
executes the enabled Exports or Saves.
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  Fig.2-4.2. Opening the data file: When the file name appears in the Filename box, it is ready to be replayed. 
    
                          

 Fig.2-4.3. Replaying fEPSP data.

Input fields for the [Replay Raw Data File] module

1. Traces: Selects the trace(s) for processing.

2. Trace time: Selects the trace time for processing.

3. Channels: Selects the channels for processing. Click the box next to the “Channels” to open the 
channel selector. Channels in green will be enabled.

4. Delay: Set this value to a value greater than zero to insert a delay between data "blocks" sent out 
by this module. It is useful for slowing down data processing. 

2
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2-4.2. Overview of the “Single_ pulse_analysis” workflow template

The "Single_pulse_analysis" workflow template consists of following modules. (located in the 3 Tabs).

In general, the replayed data is sent to the [Extract EP Measures] module, where evoked signals are 
extracted and their amplitude, slope, area, and time are measured and graphed. Phase measurement 
averages are computed and graphed accordingly when phase annotations are added. The raw data can 
be exported in either binary or ASCII ("CSV" -comma separated values- text file). The measurements 
and averages chart can be saved by "CSV" formatted text file.

Fig.2-4.4. Module configuration for the “Single_pulse_analysis” workflow template.

Tab Modules

Main Replay Raw Data File/ Display All Channels / Export Raw Data

EPSP measures Extract EP Measures (2) / Save Meausres Data (2)

Averages Compute Measure Averages (2)  / Save Measuure Averages (2)

“Main” Tab

“EPSP measures”
Tab

“Averages” Tab

Replay Raw Data File

Display 
All Channels

Extract EP Measures

Save 
Measures Data

Compute 
Measure Averages

Save 
Measure Averages

Export 
Raw Data

Extract EP Measures

Save 
Measures Data

Compute 
Measure Averages

Save 
Measure Averages
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2-4.3. Analysis of fEPSP signals

Amplitude, slope, area, and time of the extracted waveforms are measured (analyzed) in the [Extract 
EP measures] module. The extracted evoked potential waveforms are displayed at the left-most chart 
and time course of the selected measurements are graphed on the right charts. 

Fig.2-4.5. Extract EP Measures module.

1)   Raw data chart

1. The raw data chart on the left most shows the extracted evoked responses waveforms. When a 
measurement chart is clicked, the corresponding cursor appears on the raw data chart. The cursors 
for the measurements are shifted by left-clicking and dragging.

2.  You can zoom in on the raw data chart by 

   1)   left-clicking and dragging while pressing the shift button.

   2)   changing the maximum (and/or minimum) numbers for both X
         (time) and Y (amplitude) axes. Click, then, type in the new
          value(s) for the maximum and/or minimum. (Fig.2-4.6)

    *  Double-clicking anywhere on the chart to return to the original
        axis range.

3. The cursor locations can be copied to all or spe-
cific channels by right-clicking and selecting the 
[Apply Cursors to All Channels] or [Copy Cur-
sors]”. Select [Apply Cursors to All Measures] to 
copy the cursor locations to all measures. 
(Fig.2-4.7)  

Selecting [Copy Data] allows you copy the wave-
form data and paste to an excel worksheet.

        

   
2) Input fields

3) Measurement Chart1). Raw Data Chart

3) Measurement Chart

1               2                3     4           5       6            7                    8                                 9

Fig.2-4.6.

Fig.2-4.7.
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2) Input fields

1. Channel No: 
Selects the channel(s) for display by scrolling or typing 
the numbers directly. These can be changed even during 
recording or replaying.

When the channel selector is right-clicked and [Select] is 
clicked, the Channel selector box appears. The channels 
of interest are selected here as well. (Fig.2-4.8) This is 
useful for running the 4-sample system by allowing users 
to save charts to 4 different CSV files.

2. Step Filter: 
Selects the Step to be analyzed here. Step1 is selected for the top chart and Step 2 is selected for 
the bottom in the default settings. Useful for analyzing acquired LTP data with the “Single_ 
pulse_recording” workflow template. 

• In order to analyze Conductor data, ALL must be selected.

3. Shift (ms):
For analysis of paired pulse experiments. When a number greater than 0 is selected here, the cur-
sors and chart for the 2nd pulse appear.

4. X Labels: 
When this check box is clicked, the time point at which the waveform crosses the cursor is dis-
played on the Raw data chart.

5. Reset: Resets the shifted cursors to the original positions.

6. Hide phases: 
The phase bar (yellow bars with characters on the measurement chart) is hidden when this button 
is clicked. Please refer to the "Computing averages for phases" on page 38 for details.

7. Autoscale: 
When this check-box is checked, the scale for the measurement chart is automatically adjusted. 
You can zoom in and out in the measurement chart by typing the number directly in the maximal 
values for both the X and Y axes when the Autoscale button is NOT checked.

8. Average:
When this box is checked, the averaged measurements are computed and graphed. Set the number 
of traces to be averaged with the selector right to the check box. (e.g. if 2 is input and the box is 
checked, every two traces (1st and 2nd, 2nd and 3d, 3rd and 4th.) are averaged and graphed.)

9. Edit Measures: Click this button to select or change the measurement menu.

1)   Select the analysis (measurements) you desire from the [Measure Type] box to change the 
default measures.

2)    You can name the selected measures by double-clicking and typing directly into the [Custom 
Name] box.

Fig.2-4.8.
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3)   In order to have more measurements, click [Add Measures] button so another row on the table 
and new measurement chart appear.

4)   You can delete unnecessary measurements by right-clicking the custom name, and selecting
       the [Delete]. (Bottom figure in the Fig. 2-4.9)
• Click [Measures Help] button for detailed information on measurements.

5)  Click the [Hide] button to close this editor.

        

3) Measurement chart

The time course for the selected measurements (analysis) are graphed here. Zoom in or out by chang-
ing the maximum (and/or minimum) values for the X and/or Y axis. Click and type the new number 
directly.

Right clicking anywhere in the chart 
and selecting [Copy Data] allows you 
to copy the measurement data (only 
for currently selected channel) into 
an excel file. (Fig. 2-4.10)

Selecting [Capture Image] allows 
you to copy the chart image.

Measurement chart output

After you select the analysis parameters, you probably will want to output a measurement chart. When 
the check box for [Save Measures Data] is checked and the analysis workflow is run with the Green-Red 
button, the charts are saved as a "CSV" text file. 

The “Single_pulse_analysis” workflow template is designed so that the charts for Step1 and Step2 are 
exported as separate file in the default setting.

Please refer to section 2-4.5 Data output (pages 40-41) for detail.

4)

3)

2)

1)

Fig.2-4.9.

Slope1040LinearFit(uV/ms)

-265.604
-277.293
-285.283
-273.298

-280.4
-265.16

-268.563
Fig.2-4.10. Copying measurement data.
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2-4.4. Computing averages according to phases

Mobius’ [Compute Measure Averages] module calculates averages and standard deviations for the 
selected measurements (analysis) according to phases, and graph. This is useful for making a 
dose-response-curve or comparing the measurements between phases such as baseline and LTP. 

The “Single_pulse_analysis” workflow template includes the [Compute Measure Averages] module. This 
section will show you how to make a dose-response curve by using this module in the workflow tem-
plate.

If you would like to add this module to your own analysis workflow, please refer to the step1-2 at the 
section 3-2. Drug testing on page 28. 

1. Open the [Extract EP Measures] module and replay the data by clicking on the Green button. The 
first phase (baseline) will start from 0.

2. When the first phase (baseline) is fin-
ished, Pause Mobius with the YELLOW 
button. Click [Annotations] > [Add New 
phase]. (Fig.2-4.11)

3. Type in the name for the 2nd phase. (e.g. 
dose 1). When the OK button is clicked, 
the yellow bar with its name appears on 
the measurement chart in the [Extract EP 
Measures] module. (Fig.2-4.12)

NOTICE: If Mobius is stopped with the 
Black button, replaying is terminated and 
a phase bar can not be added.

4. Start Mobius with the Green button again. 

5. Pause Mobius with the YELLOW button 
when the second phase (e.g. dose 1) is 
finished. Click [Annotations] > [Add New 
phase] again.

6. Type the name for the 3rd phase (e.g. 
dose 2). When the OK button is clicked, 
the yellow bar for the 3rd phase with its 
name appears on the measurement chart.

7. Restart Mobius with the Green button. Add subsequent phases with same procedure and replay the 
data to the end.

8. You will see the values and graphs for each phase in the [Compute Measure Averages] module. 
(Fig.2-4.13, bottom)

9. The phase annotations (yellow bars) can be shifted by left-clicking and dragging. When the data is 
replayed after the phase annotations are shifted, averages and standard deviations are recalculated 
based on the new phase annotation locations.

10. If you are satisfied with the location of the phase bars, save it as your own analysis workflow.

Fig.2-4.11.

 Fig.2-4.12.
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11. In order to save the average chart to a "CSV" file, check the check-box for the [Save Measures 
Averages] module, then run Mobius with the Green-Red button.

Fig.2-4.13. [Extract EP Measures] module with phase bars (top), and the table and charts at the [Compute Measure 
Averages] module (bottom).

Input fields for [Compute Measure Averages] module

1. Channel: Selects the channel to be displayed. The selection can not be changed during replaying.

2. Use last: When this box is checked, the selected (or typed) number of data points are used for 
computation. For example, if 10 is selected, average and standard deviation are measured for the 
last 10 data points in each phase.

3. Hide: hides the measurement checked in the chart.

• Note: the chart can be zoomed up or down by clicking and changing numbers of the maximum 
and/or minimum scale(s) for both X and/or Y axis.
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2-4.5. Data output

Mobius has several modules for data output of fEPSP signals and their analysis:
 
1. Raw data (waveforms)
2. Measurement chart
3. Average chart 

All outputs are executed when Mobius is run by clickikng the GREEN-RED button with the check boxes 
for the Save or/and Export modules are checked. (The analysis workflow needs to be saved to execute 
the output.) Channels for output can be selected with channel selector in the [Replay Raw Data File] 
module.

1. Export raw data

The [Export Raw Data] module is used. The raw data (waveforms) is exported either as 1) Binary shorts 
(2 byte integer values), 2) Binary doubles (8 byte floating point values), or 3) ASCII text in "CSV" for-
mat. 

2. Save the measurement chart

The [Save Measures Data] module is used. The measurements values are saved as a "CSV" formatted 
text file. 

Fig.2-4.13. Example of  raw data (waveforms)  exported  in ASCII format displayed in Excel.

File Format Version 20071201
Session Start Time 2007/9/05 17:15:56 +09

time_ms  ch1_mV  ch2_mV  ch3_mV  ch4_mV  ch5_mV
0 0 -0.00244 -0.00366 0 -0.00488

0.05 0.001221 -0.00366 -0.00366 -0.00244 -0.0061
0.1 0.003662 -0.00366 -0.00366 -0.00244 -0.00366

0.15 0 -0.00122 0 0.001221 -0.00244
0.2 0.001221 0.001221 -0.00244 -0.00122 -0.00244

0.25 -0.00244 -0.00488 -0.00244 -0.00366 -0.00122
0.3 0.001221 -0.00122 0.001221 -0.00122 -0.00122

0.35 -0.00244 -0.00122 -0.00366 -0.00244 -0.00488
0.4 -0.00122 0 -0.00366 0.002441 -0.00244

0.45 -0.00488 -0.00244 -0.00244 -0.00244 -0.0061
0.5 0 -0.00122 -0.00488 -0.00122 -0.00488
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3. Save the average chart 

The [Save Measure Averages] module is used. The values for the averages and standard deviations are 
saved as a "CSV" formatted text file.  

File Format Version 20080210
Recording Date  2007/9/05 17:15:56 +09

STIMULATION PARADIGM 1
EPSP Slp (ms/uV)
Trace#  Phase  Time (s)  ch1  ch2  ch3
Step1-1  Baseline 0 -1.397 -2.041 -2.321
Step1-2  40.219 -1.011 -1.638 -2.49
Step1-3  80.422 -1.428 -2.305 -2.876
Step1-4  120.625 -1.06 -1.424 -2.953
Step1-5  160.813 -1.276 -1.552 -2.323
Step1-6  201.016 -1.116 -1.752 -2.665
Step1-7  241.219 -0.966 -1.614 -2.191
Step1-8  281.422 3.999 -1.436 -2.471
Step1-9  321.625 -0.948 -1.595 -2.415
Step1-10  361.813 -0.962 -1.716 -2.815

EPSP Amp (uV)
Trace#  Phase  Time (s)  ch1  ch2  ch3
Step1-1  Baseline 0 -8.545 -6.104 -7.324
Step1-2  40.219 -6.104 -7.324 -8.545

Fig.2-4.14. Example of the measurment chart saved as an Excel compatible CSV file. The chart of slope liner

   fit and minimum amplitude for Step 1 are saved. 

File Format Version: 20090613
Recording Date:  2007/7/13 06:44:04 +09

Slope1040LinearFit(uV/ms)
Phase  ch1  +/-sd  ch2  +/-sd  ch3
Baseline 32.528 5.996 -10.402 50.352 -63.225
dose 1 32.239 9.716 -28.377 55.214 -61.097
dose2 39.948 11.97 -63.761 39.029 -62.029
dose 3 48.442 5.472 -78.628 1.577 -65.594

EPSP Amp (uV)
Phase  ch1  +/-sd  ch2  +/-sd  ch3
Baseline -60.092 3.841 -246.416 5.54 -264.615
dose 1 -59.937 5.853 -250.977 6.666 -260.01
Fig.2-4.15. Example of the measurment chart saved as an Excel compatible CSV file.
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Chapter 3         Spike Sorter 

This chapter will teach you how to record and analyze spontaneous neuronal spikes (single unit activi-
ties) either from neuron cultures or brain slices using available workflow templates. In this chapter you 
will learn:

1. How to record spontaneous neuronal spikes (single unit activities). 
2. How to test drug effects. 
3. How to replay and analyze spontaneous neuron spikes (single unit activities).

3-1. Recording spontaneous neuronal spikes (single unit)

There are 5 workflow templates available for recording spontaneous neuronal spikes (single unit):

1. Spontaneous_recording (Recording WITHOUT any real-time analysis).
2. Spike_recording (Recording with extracting spikes and their frequency analysis).
3. Spike_recording_filter (2 + filter).
4. Spike_recording_cluster (Recording with extracting, clustering spikes, and their frequency analyses).
5. Spike_recording_filter_cluster (4+filter).

Opening the workflow template

1. Click [Workflow] > [New] > [From Template]. (Fig.3-1.1)

2. Select [SU-MED640_1280x1024] folder.
Select [Spikes] > [Spontaneous_recording] folders. Select the workflow template.

• Go to [Basic_recording] folder for the “Spontaneous_recording” workflow template.

Fig.3-1.1.
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3-1.1. Setting the acquisition parameters

All the recording workflow templates include the [Acquire MED64 Data] module. Acquisition parameters 
are set in this module. 

1. #Traces: Number of Traces (sweeps).

2. Auto-pause:     

Mobius will pause automatically when the current trace is finished if the box is checked. The trace 
interval set below becomes invalid when this box is checked. Mobius re-starts by clicking either of 
Green button or Green-Red button.

3. Trace duration: Sampling (Recording) time for each trace.

4. Trace interval: 

Interval between traces. (from the beginning of the first trace to the beginning of the next trace.)

• In the default setting, signals are recorded for 5 minutes every 30 minutes (as seen in the fol-
lowing figure), which is repeated 48 times. Mobius will run for 24 hours in total.

• The trance interval becomes invalid when Auto-pause is checked.

5. Range (V):

Maximum input signal level. This setting should be adjusted according to the signal amplitude to 
achieve the maximal dynamic range. 1000 V is usually good enough for recording of neuronal 
spikes.

6. Low cut freq (Hz): 

High pass filter. Select 0.1 Hz, 1.0 Hz, 10 Hz or 100 Hz. If 1.0 Hz is set, the signals with  frequencies 
lower than 1 Hz are filtered out. 100 Hz is recommended for the recording of neuronal spikes.

7. Channels:

Select the channels for recording here. When the square box is clicked, the channel selector pops up. 
The enabled recording channels are colored green.

8.  Save raw data:

When Mobius is started by clicking the Green-Red recording button while the [Enable storage] is 
checked, the raw data is saved. The file name can be modified. 

(1)

(2)

(3)

(4)

(5)

(6)

(7)
Fig.3-1.2. [Acquire MED64 Data]
workflow template.

5 min.

30 min. Recording

5 min.
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3-1.2. Execution buttons

The workflow template is run and stopped 
(paused) with the right execution buttons.
                                                           

3-1.3. Before starting your experiment

When the Mobius is run for the first time after turning on your MED64PC, it will take some time that sig-
nals appear on the screen and stabirize around 0 levels at all 64 channels. Before you start your exper-
iment, run Mobius with green button and make sure that the baselines at all 64 channels stabirize 
around 0 V.

When you run workflow including [Extract Spikes] for the first time after turning on your MED64 PC, 
check [Disable] at the [Extract Spikes] module so that any signals are NOT extracted, then run 
workflow. Otherwise, Mobius might stop trying to extract the irregular signals.

CAUTION:
 
• Make sure that the hard drive has enough free space when you start a long-term recording.

Recording with all 64 channels for 1 hour creates a 9.216GB file.
(9.216GB is represented as 9,000,000KB, 8,739.06MB, or 8.58GB in the Windows.)

• Avoid saving data to the drive where the OS is installed (usually C drive). Save it to a separate hard 
drive in the following cases:
  1)  When trace duration is set to longer than 30 minutes. 
  2)  When trace duration is set to longer than 5 minutes and # Traces is greater than 12.

• Extracting and/or clustering spikes can slow down Mobius' data processing and appear to freeze 
when it extracts more spikes than it can analyze. This most often happens when non-biological sig-
nals cross the spike extraction thresholds on all channels at once. (e.g. Unexpected noises cross the 
thresholds or the baseline fluctuates due to vibration.) 

• It is recommended you start your new experiments WITHOUT on-line (real time) extraction or clus-
tering (using the Spontaneous Recording template or disabling spike detection). Perform your 
experiments with real-time analysis when you are familiar with your preparation and experiments. 
When recording is done with extraction, clustering, and filtering, please follow the instructions in 
section 1-2. Important notice on pages 4-5.

     Stop                 Run WITHOUT        Run WITH        Pause
                          saving data             saving data

Fig.3-1.3. Execution buttons.

Fig. 3-1.3. Baseline traces before stabilizing (left) and
 stabilized baseline (right). Check the [Disable] box 
(bottom-right) so thas signals are NOT extracted. 
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3-1.4. Recording without on-line (real-time) analysis 
            -Using “Spontaneous_recording” workflow template-

Overview of the “Spontaneous_recording” workflow template

The “Spontaneous_recording” workflow template consists of following modules located in the 2 Tabs of 
“Main” and “Monitor”.

Acquired signals are simply displayed at all 64 channels and an any selected channel. The data can be 
exported to binary or ASCII (“CSV” formatted text file).

Tab Modules

Main Acquire MED64 Data / Display All Channels  / Export Raw Data

Monitor Display Single Channel

“Main” tab

“Monitor” tab

Display All Channels 

Acquire MED64 Data 

Export Raw Data 

Display Single Channel

Fig.3-1.6. Control panels in the “Spontaneous_recording” workflow template.
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Recording spontaneous neuronal spikes (single unit activities) without any 
on-line analysis 

The online spike extracting can slow-down Mobius’ data processing and cause it to stop when it extracts 
more spikes than it can analyze. It is recommended to record signals using this template until you are 
familiar with your preparation and experiment. Analysis and exporting can be done later off-line.

1. Open the “Basic_recording” workflow template. (Refer to page 43)

2. Change the recording parameters in the [Acquire MED64 Data] module. 
(Refer to section 3-1.1.Setting the acquisition parameters on page 44)

3. Make sure that [Export Raw Data] is NOT enabled. 
• This can be done later.

4. Make sure that [Save raw data] is CHECKED.

5. Save it as your recording workflow.

• Click [Workflow] > [Save as]. (Fig.3-1.7) The workflow will be 
saved as a moflo. file.

• The data file (.modat file) will be saved in the same folder as the 
Recording workflow.

Refer to page 10 for the data and workflow files generated after recording. 

6. Run Mobius with the GREEN-RED button.
• Mobius will require you to save the workflow as your own if you try to start Mobius with the 

Green-Red button without having saved it already.

7.  You can focus on a specific channel it the “Monitor” tab. Channels can be changed during recording.

Fig.3-1.7.
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Fig.3-1.8. Recording with “Basic_recording” workflow template, “Main” Tab (top) and “Monitor” tab (bottom).

Scales can be changed

The time scale is changed here  

 

Scale for amplitude
can be changed by

clicking and typing
in the values for the 
maximum and/or 

The maximum is 10 ms
 Channel can be changed here

during recording. 

minimum
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3-1.5. Recording with extracting spikes and their frequency analysis
          -Using the “Spike_recording(_ filter)” template-

Overview of the “Spike_recording(_filter)” workflow templates

The “Spike_recording(_filter)” template consists of the following modules.

Spikes crossing over pre-defined thresholds are extracted, and the spike frequency of all extracted 
spikes is computed and graphed during recording. You can monitor that 1) spikes are extracted, 2) the 
extracted spikes’ waveforms, 3) the spike frequency chart at the [Display Spike Measures] control 
panel.

In the “Spike_recording_filter” workflow template, 2 sets of [Filter Raw Data] modules are added in the 
“Filter” Tab. In this workflow template, acquired data can be filtered with selected filter menu before 
sent to the [Extract Spikes] module. (Refer to Fig.3-1.10). In the “Filter” tab, the top [Display Single 
Channel] module shows the original non-filtered data while the bottom module shows filtered data. 
(Refer to the bottom figure on the Fig.3-1-11).

Tab Modules

Main Acquire MED64 Data / Display All Channels / Export Raw Data

Spike
Extract Spikes / Compute Spike Freqs / Save Spikes / Save Spike Freqs / Display Spike
Measures

Filter* Filter Raw Data (2) / Display Single Channel (2)

*Filter Tab is NOT available with the “Spike_recording” workflow template

Fig.3-1.9. Module configuration for the  “Spike_recording”  workflow template.

“Main” Tab

“Spikes” Tab

Acquire MED64 Data

Display 
All Channels

Export 
Raw Data Extract Spikes

Compute Spike Freqs

Display Spike Measures

Save Spike Freqs

Save Spikes
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Fig.3-1.10. Module configuration for the “Spike_recording_filter” workflow template. 

Main Tab

Spike Tab

Filter Tab

Extract Spikes Compute Spike Freqs

Compute Spike Freqs

Save Spike Freqs

Display Spike Measures

Spikes are extracted (top),

Filter Raw Data (1)

Display Single channel
(Raw data is displayed)

Display Single channel
(Filtered data is displayed)

Fig.3-1.11. Control panels in the “Spikes” and “Filter” tab for the “Spike_recording_filter” template. The “Main” tab 

Extracted spikes’ waveform (right),
The time course of spike frequency

  is same as “Spontaneous_recording”. (Fig.3-1.6).

(bottom) are displayed.
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Recording spontaneous neuronal spikes with on-line spike extracting and 
their frequency analysis

[Extracting spikes] can slow down data processing and Mobius can even freeze when it extracts more 
spikes than it can process. (Refer to CAUTION on the page 45) Please follow the instructions below to 
avoid stopping during recording when this workflow template is used (or this module is used for acqui-
sition).

• Select 100Hz for the low-cut filter. (Accidental low-frequency noise might cause to stop 
Mobius).

• Avoid enabling any [Export] or [Save] modules when raw data is saved. Once raw data is 
saved, you can export during off-line analysis.

• Set the trace duration (recording time) to less than 10 minutes and the trace interval to longer 
than the trace duration so that the analysis can catch up with the acquisition during the trace 
interval. Particularly, keep the trace duration short for long-term recording lasting days, 
weeks, or months.

• Decrease the number of recording channels.

1. Open the “Spike_recording(_filter)” workflow template. (Refer to page 43)

2. Change the acquisition parameters in the [Acquire MED64 Data]. 
(Refer to section 3-1.1. Setting acquisition parameters on page 44)

3. Select the channels for recording. Click the box next to “Channel” in the [Acquire MED64 Data] 
module to have channel selector. 

4. Make sure that [Export Raw Data] is NOT checked (Uncheck the check-box).
• Once raw data is saved, this can be done later off-line.

5. Start Mobius with the Green button and run the workflow template for a few minutes to see signals, 
and then stop. Set the analysis parameters.

1) Change the filter menu depending on the acquired signals. 
    (If the “Spike_recording” template is used, this is not necessary.)

2) Set the thresholds. 
• Refer to section 3-3.2 Analyzing the spike rate on pages 63-67 for detail

3) Change the parameters for [Compute Spike Freqs]. 

4) Make sure [Save Spikes] and [Save Spike Freqs] are NOT enabled.

•   It is not recommended to enable these modules during recording with extracting spikes. 
 These can be done later off-line once raw data is saved.

6. Run Mobius with the Green button, then make sure that the thresholds you set are OK. 
• Thresholds can be changed during recording. But it is not recommended to do so during 

recording.

7. Save as your own recording workflow.(Refer to page 47) The workflow will be saved as moflo.file.

• The data file (.modat file) and the Analysis workflow (including all analysis module selected for 
the recording workflow and [Replay Raw Data File] module) will be saved in the same folder. 
(Refer to pages 9-10)
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8. Make sure that the Save raw data in the [Acquire MED64 Data] module is checked, then run your 
workflow with the GREEN-RED button.

• Start recording without on-line extraction to be 
safe. Check the [Disable] button in the [Extract 
Spikes] module so that spikes are NOT 
extracted. (Fig.3-1.12) However, when this 
button is checked, extracted spikes or spike 
frequency chart can NOT be displayed during 
recording.

• It is strongly recommended to start recording 
with the Disable button checked during long 
term recording over several days or weeks.

• Mobius will require you to save the workflow as your own if you try to start Mobius with the 
Green-Red button without having it already.

Fig.3-1.12. Disable button.

Fig.3-1.13. Spike extraction and spike frequency analysis.
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3-1.6. Recording with on-line (real-time) spike sorting 
           -Using the “Spike_recording(_filter)_ cluster template-

Overview of the “Spike_recording(_filter)_cluster” workflow templates

The “Spike_recording(_filter)_cluster” workflow template consists of following modules.

With these workflow templates, spikes crossing the pre-defined thresholds are extracted, and sorted 
(clustered) based on the waveform shapes. The spike frequencies of each spike cluster are computed 
and graphed. You can monitor 1) that spikes are extracted, 2) different spike clusters’ waveforms 
grouped by clusters, and 3) cumulated spike frequencies of each spike clusters during recording.

For the “Spike_recording_filter_cluster” workflow template, 2 sets of [Filter Raw Data] modules are 
added in the “Filter” Tab. (Fig.3-1.15) The acquired data can be filtered with selected filter menu before 
sent to the [Extract Spikes] module. (Refer to Fig.3-1.15). In the “Filter” tab, the top [Display Single 
Channel] module shows the original non-filtered data while the bottom module shows filtered data.
 (Refer to the bottom figure on the Fig.3-1-11).

Tabs Modules

Main Acquire MED64 Data / Display All Channels / Export Raw Data

Spike
Extract Spikes 　/ Cluster Spikes / Compute Spike Freqs / Save Spikes / Save Spike
Freqs / Display Spike Measures

Filter* Filter Raw Data (2) / Display Single Channel (2)

*Filter Tab is NOT available with “Spike_recording” workflow template

Fig.3-1.14. Module configuration for the “Spike_recording” workflow template.
  

“Main” Tab

“Spike” Tab
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Fig.3-1.16. Control panels in the “Spikes” Tab for the “Spike_recording(_filter)_cluster” workflow template. The “Main” 
and “Filter” tabs are same as “Spike_recording_ filter”.(Refer to Fig.3-1.11)

Fig.3-1.15. Module configuration for the “Spike Sorting_filter”  workflow template. 

“Main” Tab

“Spike” Tab

“Filter” Tab

                         

Cluster SpikesExtract Spikes Compute Spike Freqs

Save Spike Freqs

Save Spikes

Display Spike
Measures
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Recording spontaneous activities with on-line spike sorting

The purpose of clustering spikes is to identify and separate signals referred from multiple cells acquired 
on a single channel (electrode) based on their waveforms.The extracted spikes are treated as vector 
inputs to define centroids (center of mass vector). However, the centroids can not be defined unless 
“frozen” (ignoring any incoming spikes to alter centroids) and will change depending on the incoming 
spikes. On-line spike clustering does not have much meaning unless it gives you an idea how many dif-
ferent kinds of spikes you have on each channel (electrode).

More importantly, clustering can slow down Mobius’ data processing and appear to stop it when the 
analyzing can not keep up with data processing. Thus, it is recommended to: 

1)  Use this workflow template to get an idea of how many kinds of spikes you have before starting 
acquisition.

2)  Start acquisition with the [Disable] button checked. Spikes will NOT be extracted during acqui-
sitions. You will not be able to see the extracted spikes’ waveforms or spike frequency chart.

It is strongly recommended to do so when recording is performed for long term.

When on-line spike sorting (clustering) is performed, please follow the instructions below: 

• Select 100Hz for the low-cut filter. (Accidental low-frequency noise might cause to stop 
Mobius.)

• Do NOT enable any [Export] or [Save] module when raw data is saved. 
(Exporting can be done later off-line.)

• Set the Trace duration (recording time) to less than 10 minutes and the Trace intervals for lon-
ger than the trace duration so that the analysis catches up with the acquisition during the 
trace interval. Particularly, make the trace duration even shorter for long-term recording last-
ing days, weeks, or months.

• Decrease the number of recording channels.

1. Open the “Spike_recording(_filter)_cluster” workflow template. (Refer to page 43)

2. Change the acquisition parameters in the [Acquire MED64 Data] module.
(Refer to section 3-1.1. Setting the acquisition parameters on page 44)

3. Select the channels for recording. Click the box next to “Channel” in the [Acquire MED64 Data] 
module to have channel selector. 

4. Make sure that [Export Raw Data] is NOT Enabled.
• This can be done later off-line once raw data is saved.

5. Run the workflow template (clicking the Green button) for a few minutes to see signals on the 
screen, then stop it. Set the analysis parameters.

1) Change the filter menu depending on the acquired signals. (Refer to pages 64-65)
• If the “Spike_recording_cluster” template is used, this step is not necessary.) 

2) Set the thresholds for spike extraction. (Refer to page 75)

3) Modify the parameters for clustering spikes (in the [Cluster Spikes] module). 
• Refer to section 3-3.3 Spike Sorting (pages 76-78) for detail.
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4) Make sure that [Save Spikes] and [Save Spike Freqs] are NOT enabled.

• It is not recommended to enable these while recording and extracting spikes. These can be 
done later off-line once raw data is saved.

6. Run Mobius (clicking the Green button) to make sure that the thresholds you selected are OK.

• Thresholds can be changed during recording. But it is not recommended to do so during 
recording.

7. Save as your own recording workflow. (Refer to page 47). The workflow will be saved as .moflo file.

•  The data file (.modat file) and the Analysis workflow (including all analysis modules selected 
for the recording workflow and [Replay Raw Data File] module) will be saved at the same 
folder. (Refer to pages 9-10)

8. Make sure that the [Save raw data] is checked, then run the workflow with the GREEN-RED button.

• Start recording without on-line extraction to be safe. 
Check the [Disable] button in the [Extract Spikes] 
module so that spikes are NOT extracted. (Fig.3-1.17) 
However, when this button is checked, extracted spikes 
and/or spike frequency chart can NOT be displayed 
during recording.

• It is strongly recommended to start recording with the 
[Disable] button checked during long term recording 
over several days or weeks. Fig.3-1.17. Disable button.

Fig.3-1.18. Spike sorting.
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3-2. Drug testing

The [Compute Measure Averages] module calculates averages and standard deviations for the spike 
frequencies for all the experiment’s phases. This is a useful tool for making a dose-response curves or 
comparing phases before, during and after drug applications. This section will demonstrate how to 
make a dose-response curve for spike frequencies using this module.

Since this module is at the end of the analysis chain, it can slow down the data processing and cause 
Mobius to stop during your experiment if you perform these analyses on-line. So, it is recommended 
not to use this module during recording unless you are familiar with your preparations and experiment. 
All analysis introduced in this section can be done later off-line. 

An alternate solution to avoid stopping is to just set the phase-annotations (yellow bars) without 
on-line analysis during recording, and then analyze later off-line. (The location of the phase bars will be 
saved in your analysis workflow.) To do this, skip following steps 1-3 and start with 4.

1. Open the “Spike_recording(_filter)” (or any other) workflow template.

2. Add the [Compute Measure Averages] and [Save Measure Averages] to this workflow template.

1)   Make a new tab. Click [Layout] > [Add Tab], then type in the new tab’s name. (Fig.3-2.1)

2)   Open the Editor in the new tab. (Click [Workflow] > [Edit]) (Fig.3-2.2)
                                                                                      

3)   Click the [Compute Spike Freqs] in the left 
“Workflow” box, then double-click [Compute 
Measure Averages] in the right “Available task 
panels”. (Fig.3-2.3)

You will see the [Compute Measure Averages] 
module shift to the left box, under the 
[Compute Spike Freqs] module. (Fig.3-2.4) 
The control panel for this module appears in 
the new tab. (Fig.3-2.5)

Fig.3-2.1. Make a new tab. 
 Fig.3-2.2. Editor is opened in the new tab.

Fig.3-2.4.

 Fig.3-2.3.
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4)    Click the [Compute Measure Averages] module in the left “Workflow box”; then double-click on 
[Save Measure Averages] in the right “Available task panels” so that the [Save Measure 
Averages] is moved to the “Workflow box”, under the [Compute Measure Averages] and the 
control panel for this module appears in the tab.

 Averages and standard deviations for the spike frequencies will be measured and graphed in the 
[Compute Measure Averages] control panel.

3. Open the [Filter] tab. Run Mobius (click the Green button) and modify the filter menu (Refer to 
page 64), and then stop it by clicking the Black button. Set the thresholds and parameters for 
[Compute Spike Frequency]. (Refer to pages 65-67)   

4. Start Mobius by clicking the Green button. When you are satisfied with the new thresholds settings 
and other analysis parameters, stop and save it as your own workflow. (Refer to page 47)

5. Run Mobius by clicking the GREEN-RED button. The first phase (baseline) will start from time 0.

Fig.3-2.5. Control panels for the [Compute Measure Averages] and [Save Measure Averages] modules (top-
               left) and all modules in the completed new workflow (bottom-right).
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6. Pause Mobius by clicking YELLOW button 
when the first phase (baseline) is fin-
ished. Click [Annotations] > [Add New 
phase]. Type in the name for the 2nd 
phase. (e.g. dose 1.) (Fig.3-2.6)

Do NOT stop with the Black button. If it is 
stopped, the experiment will end and new 
phases will NOT be added.

7. When OK button is clicked, the yellow bar 
with the chosen name appears in the 
[Display Spike Measures] module’s spike 
frequency chart. (Fig.3-2.7)

8. Re-start Mobius with the GREEN-RED but-
ton. 

Time continues running during pausing in 
the measurement charts. 

9. When the second phase (e.g. dose 1) is finished, pause Mobius with the YELLOW button. Click on 
[Annotations] > [Add New phase].

10. Type in the 3rd phase name (e.g. dose 2). The yellow bar with the name appears in the spike fre-
quency chart when the OK button is clicked.

11. Start Mobius again with GREEN-RED button. Add subsequent phases following the same procedure 
and run Mobius until the end of experiment.

12. You can see the average table and graph for each phase in the [Compute Measure Averages] mod-
ule (in the “Averages” tab) (Refer to Fig. 3-2.8)

•  The phase annotations (yellow bars) can be shifted by left-click and dragging during off-line 
analysis. Averages and standard deviations will be calculated based on the new phase annota-
tions when the data is replayed.

Fig.3-2.6. Making a new phase.

Fig.3-2.7. New phase is added.
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Input fields in the [Compute Measure Averages] module

1. Channel: Selects the channel to be displayed. The selection can not be changed while running 
workflow.

2. Use last: When this box is checked, the selected (or typed) number of data points are used for 
computations. This is mostly used for off-line analysis (Refer to page 72). 

3. Hide: hides the measurement checked in the chart.

• Note: the chart can be zoomed up or down by clicking and changing numbers of the maximum 
and/or scale(s) for both X and Y axis.

Fig.3-2.8. Computed measure averages. [Display Spike Measures] module with phase bars (top) and [Compute
Measure Averages] module (bottom).
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3-3. Replay and analysis of acquired data

The Mobius data files (.modat) are opened and replayed with the [Replay Raw Data File] module, and 
analyzed using modules such as [Extract Spikes], [Cluster Spikes], and [Compute Spike Freqs]. You will 
design your Analysis workflow by combining those modules for replay and analysis of the acquired data. 
The quickest way to replay and analyze the spike data is using the Analysis workflow template, which 
will be introduced in this chapter.

The Analysis workflow with the [Replay Raw Data File] and the analysis modules you selected for your 
recording will be automatically saved to the same directory when you run recording workflow with the 
Green-Red button. These analysis workflows can also be used for quickly performing analysis. 

3-3.1. Replaying acquired data

1. Open the analysis workflow template. Click [New] > [From Template]. Select 
[SU-MED640_1280x1024] folder.

Select [Spikes] > [Spike_analysis] folders, then select an analysis workflow template. Four tem-
plates are available for analyzing spontaneous neuron spikes (single unit activities). 

1) ”Spike_frequency_analysis”:
      Spikes are extracted and spike frequency
      is computed and graphed.

2) ”Spike_frequency_analysis_filter”:  
      1 + filter

3) “Spike_sorting”:
      Spikes are extracted and sorted 
      (clustered). Spike frequencies of 
       clustered spikes are computed and
       graphed.

4) “Spike_sorting_fiter:
      3 + filter
 

                                                                        
• In order to open your own analysis workflow, click [Workflow] > [Open], and then select the 

workflow file (.moflo).

2. Open the data file by clicking the box next to the “Filename” and select the desired .modat file. 
When the file name appears in the Filename box as seen on the right figure of the Fig.3-3.2, the 
data is ready to be replayed by clicking the Green button or Green-Red button.

• Opening large data files can take several minutes. (e.g. Opening 10GB data takes over 1 min-
ute.) 

3. The acquired data is just replayed when the Green button is clicked. Clicking the Green-Red button 
while checking the [Enable] check-box executes the Export or Saves.

Fig.3-3.1. Opening analysis template.
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Input fields for the [Replay Raw Data File] module

1. Traces: Sects the trace(s) for processing.

2. Trace time: Selects the trace time for processing.

3. Channels: Selects the channels for processing. Click the box next to the “Channels” to open the 
channel selector. Channels in green will be enabled.

4. Delay: Set this value to a value greater than zero to insert a delay between data “blocks” sent out 
by this module. It is useful for slowing down data processing. 

2

Fig.3-3.2. Opening a data file. When the file name appears in the Filename box, it is ready to be replayed.

Fig.3-3.3. Replaying spontaneous data.
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3-3.2. Analyzing the spike rate

This section describes how to analyze the spike rate with the “Spike_frequency_analysis_filter (or, 
Spike_frequency_analysis)” workflow template. These Analysis templates consist of following modules 
located in the Tabs of “Main”, “Spike”, “Filter”, and “Averages”.

The raw data is filtered by the selected filter menu. Spikes crossing pre-defined thresholds are 
extracted. Spike frequencies of all extracted spikes are computed and graphed. Raw data can be 
exported as a binary or ASCII (“CSV” formatted text) file. Waveforms of extracted spikes, time stamp, 
and spike frequency charts can be saved as “CSV” formatted text file.

The [Compute Measure Averages] module calculates and graphs the spike frequency averages for the 
different phases. In the “Spike_frequency_analysis” template, the replayed data is sent to [Extract 
Spikes] module without filtering.

Tab Modules

Main Replay Raw Data File / Display All Channels / Export Raw Data

Spike
Extract Spikes 　/ Compute Spike Freqs / Save Spikes / Save Spike Freqs / Display Spike
Measures

Filter* Filter Raw Data (2) / Display Single Channel (2)

Averages Compute Measure Averages / Save Measure Averages

* “Filter” tab is not available with the “Spike_friquency_analysis” workflow template.

Fig.3-3.4. Module configuration for the “Spike_frequency_analysis_filter” workflow template.

“Main” tab

“Spikes” tab

“Filter” tab

“Averages”  tab
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1. Set the filter menu

Replay data by clicking the Green button. Change the filter menu accordingly.

• Select the type of filter in the “Filter Type” drop down menu and the cut-off freqs (or time) 
scale in the bottom drop down menu below.

• The top chart displays the raw data and the bottom chart displays the filtered data.The scale 
for amplitude (Y axis) can be modified by clicking and typing directly in the maximum and /or 
minimum amplitude values. (Fig.3-3.6)

• The time (X axis) can be changed by selecting numbers in the “Duration” drop down menu. 
The maximum duration is 10 msec. (Fig.3-3.6)

Fig.3-3.5. Control panels on the “Spike” tab in the “Spike_frequency_analysis_filter” workflow template. Refer to
Fig.3-3.3 for  the “Main” tab, Fig.3-3.6 for  the “Filter” tab, and Fig.3-3.20 for the “Averages” tab.

Extract Spikes Compute Spike Freqs

Save Spikes

Save Spike Freqs

Display Spike Measures

* Spikes are extracted (top-left), 
* Waveforms of Extracted spikes

 * Time course of spike 

are displayed.

Ex

  (top-right) 

   frequencies (bottom)
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2. Set the Thresholds

Open the “Spike” tab, and set the thresholds and 
pre/post times for spike extraction in the [Extract 
Spikes] module (table). The thresholds are displayed 
on the top-left chart in the [Display Spike Measures] 
module.

1)　The values for thresholds and pre/ post times can be 
changed by double clicking and typing them in directly. 
(Fig.3-3.8)

2)   The values can be applied to all another channels by 
right-clicking the number and selecting “Apply to ALL”. 
(Fig.3-3.9)

• Please refer to Mobius User Guide (5.2.3. Extract Spikes) 
for more information on thresholds and pre/post times.

• Disable button: when this check box is checked, spikes are 
NOT extracted. It is used mostly for acquisition.

• Channel limit selector: the maximum numbers of spikes to be extracted per 1 second at a 
channel are selected here. This is useful for preventing crashing due to unexpected high-fre-
quency noise during acquisition.

Change the duration

Fig.3-3.6. The filter tab. The top display shows the raw data and the bottom display shows the filtered data.  

(Scale for X axis)
here 

Fig.3-3.7. [Extract Spikes] module.

 Fig.3-3.9.

Fig.3-3.8.
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3. Set the Parameters for computing spike frequency

Modify the parameters in the [Compute Spike Freqs] module. (Fig.3-3.10) 
This module creates a cumulative record of spike frequency changes. 

The default setting has 1 second selected for the Binning window size. 
Extracted spikes are counted every 1 second. Selecting “Trace” instead of 
“Arbitrary (s)” means the spikes are counted for the whole trace.

4. Modifiy the charts in the [Display Spike Measures]

The [Display Spike Measures] module consists of 3 charts:

1)  Trace chart (top-left):
      Raw data and thresholds are displayed. Extracted spikes are high-lighted in light green color.    
                                     
2)  Extracted Spikes chart (top-right): 
     Extracted spikes’s waveforms are displayed.

3)  Spike Frequency chart (bottom):
     Spike frequencies are displayed.

Zoom in or out the charts module using the following procedure:

• [Trace] chart (top-left):

The time scale for amplitude can be changed by clicking and typing in 
the desired minimum and/or maximum values. (Fig.3-3.11)

The time duration can be changed in the “Duration” drop down menu. 
(Fig.3-3.12)

• [Extracted Spikes] chart (top-right):

The scale for amplitude and time can be changed by 
clicking and typing in the desired minimum and/or max-
imum values. (Fig.3-3.11)

• Spike frequency chart: 

Can not be changed.

5. Replay data by clicking the Green button with the new parameters. When you are satisfied with the 
new threshold values, save as your own analysis template. (Refer to page 47) The output will be 
the data you have selected.

Fig.3-3.10.  
                      

Fig.3-3-11.

Fig.3-3.12.
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Fig.3-3.13. Spikes extractions and their frequencies analysis.
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Data output

Now, you are ready to generate data. When the workflow is run by clicking GREEN-RED button with the 
boxes for the Save and/or Export modules checked, the data are saved and/or exported. 

Channels for the Saving/Exporting are chosen with the channel selector in the [Replay Raw Data] mod-
ule. Channels shown with green will be enabled. File names for all Save/Export modules can be modi-
fied by directly typing them into the Filename modifier box. 

1. Export raw data

The [Export Raw Data] module is used. The raw data (waveforms) are exported either as 1) Binary 
shorts (2 byte integer values), 2) Binary doubles (8 byte floating point values), or 3) ASCII text in 
“CSV” format. 

File Format Version 20071201
Session Start Time 2004/7/28 17:29:48 +09

time_ms  ch1_mV  ch2_mV  ch3_mV  ch4_mV  ch5_mV  ch6_mV
0 0.006348 -0.00293 -0.00537 0.001953 -0.00635 -0.00391

0.05 0.001465 -0.00195 -0.00391 0.003906 -0.0083 -0.00684
0.1 0.001953 -0.00244 -0.00098 -0.00244 -0.00635 -0.00977

0.15 0.005859 -0.00244 -0.00098 0.000488 -0.00488 -0.00781
0.2 0.006836 -0.00195 -0.00244 -0.00049 -0.00635 -0.00732

0.25 0.006348 -0.00635 -0.00391 0.001465 -0.00195 -0.00342
0.3 0.003418 -0.00635 -0.00049 -0.00195 -0.00342 -0.0083

0.35 0.002441 -0.00293 0.002441 -0.00244 -0.00195 -0.00391
0.4 0.005859 -0.00146 0.003418 -0.00195 -0.00244 -0.00049

0.45 0.004395 -0.00293 0 -0.00391 -0.00244 -0.00342
0.5 0.005371 -0.00439 -0.00049 -0.00684 -0.00391 -0.00586

0.55 0.005371 -0.00342 -0.00342 -0.00928 -0.00488 -0.00391
0.6 0.006348 -0.00146 -0.00195 -0.00928 -0.00342 -0.00293

0.65 0.005859 -0.00244 -0.00781 -0.01074 -0.00537 -0.00635
0.7 0.007324 -0.00146 -0.00439 -0.00977 -0.00391 -0.00342

0.75 0.005859 -0.00146 -0.00488 -0.00977 -0.00732 -0.00488
0.8 0.002441 -0.00195 -0.00244 -0.00879 -0.00488 0.000977

0.85 0.004883 -0.00342 -0.00391 -0.01025 -0.00391 -0.00488

Fig.3-3.14. Example of raw data exported with ASCII displayed in Excel.
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2. Save extracted spikes and time stamps 

The [Save Spikes] module is used.

1) Time stamp only, or 
2) Time Stamps, and waveforms of all extracted spikes 

are saved as a “CSV” formatted text file.

File Fo 20071201

Sessio2004/7/28 17:29:48 +09:00

Trace 60262

chan

nel

 time_of_day  within_session_time within_s

ession_ti

me_ms

within_trac

e_time_ms

cluster_i

d

trace

_num

pre_ms post_

ms

 y0_mV  y1_mV  et

2  17:29:48.326  0d:00:00:00.326 326.9 326.9  none 1 1 2.5 0.00681065 0.006670749 0

2  17:29:48.397  0d:00:00:00.397 397.95 397.95  none 1 1 2.5 0.010181873 0.011403289 0

2  17:29:48.411  0d:00:00:00.411 411.5 411.5  none 1 1 2.5 0.002042739 0.000903023 -

2  17:29:48.437  0d:00:00:00.437 437.45 437.45  none 1 1 2.5 -0.001707017 -0.002345263 -

2  17:29:48.495  0d:00:00:00.495 495.3 495.3  none 1 1 2.5 -0.0084337 -0.011750365 -

3  17:29:48.009  0d:00:00:00.009 9.9 9.9  none 1 1 2.5 0.00425918 0.002154879

3  17:29:48.016  0d:00:00:00.016 16.4 16.4  none 1 1 2.5 -0.007372998 -0.005078022 -

3  17:29:48.027  0d:00:00:00.027 27.5 27.5  none 1 1 2.5 0.002399721 0.000965411 0

3  17:29:48.041  0d:00:00:00.041 41 41  none 1 1 2.5 0.00108115 0.001782467 0

3  17:29:48.056  0d:00:00:00.056 56.25 56.25  none 1 1 2.5 -0.001126919 -0.002629422 -

3  17:29:48.063  0d:00:00:00.063 63.85 63.85  none 1 1 2.5 -0.004111407 -0.004061442 -

3  17:29:48.068  0d:00:00:00.068 68.35 68.35  none 1 1 2.5 0.004206802 0.004814135 0

3  17:29:48.077  0d:00:00:00.077 77.65 77.65  none 1 1 2.5 0.000747327 0.001243812 0

3  17:29:48.095  0d:00:00:00.095 95.75 95.75  none 1 1 2.5 0.001295781 0.001522645

3  17:29:48.099  0d:00:00:00.099 99.35 99.35  none 1 1 2.5 0.001450416 0.000778917 0

3  17:29:48.12  0d:00:00:00.12 120.2 120.2  none 1 1 2.5 -0.005230252 -0.004370654 -

3  17:29:48.13  0d:00:00:00.13 130 130  none 1 1 2.5 -0.000629679 0.000788942 0

3  17:29:48.134  0d:00:00:00.134 134.4 134.4  none 1 1 2.5 0.008337011 0.007848071 0

Fig. 3-3.15. Example of the Time Stamps and Waveforms saved as a “csv” file displayed in Excel.
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3. Save the spike frequency data 

The [Save Spike Freqs] module is used. The spike frequency data is saved as a “CSV” formatted text 
file. 

4. Save the average chart

The [Save Measure Averages] module is used. The averages and standard deviations are saved as 
a “CSV” formatted text file. (Refer to section 3-3.3.Compute averages of spike frequency by phases.)

File Format Version 20071201
Session Start Time 2004/7/28 17:29:48 +09

time_secs phase  ch1  ch2  ch3  ch4
  NC  NC  NC  NC

1 Baseline 5 20 69 1
2 2 32 51 0
3 9 58 37 0
4 13 20 6 0
5 6 5 8 0
6 13 1 2 0
7 5 14 3 0
8 1 0 3 0

Fig.3-3.16. Example of the spike frequency data saved as a “CSV” file displayed in Excel.

File Format Version 20080212
Session Start Time 2008/10/01 16:16:43 +09

Channel Number 57
Measure  Baseline  +/-sd  dose 1  +/-sd  dose 2
NC 0.143 0.655 0.05 0.224 0.895

Channel Number 58
Measure  Baseline  +/-sd  dose 1  +/-sd  dose 2
NC 0.857 2.833 4.55 9.139 22.211

Channel Number 59
Measure  Baseline  +/-sd  dose 1  +/-sd  dose 2

Fig.3-3.17. Example of the average chart saved as a “CSV” file diplayed in Excel. (Only channel 57, 58, 
and 59 are saved.)
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3-3.3. Computing spike frequency averages according to phase
            -Making the dose-response-curve-

The [Compute Measure Averages] module calculates spike frequency averages and standard deviations 
according for all experimental phases. This is a useful tool for making a dose-response curve. This sec-
tion will walk you through making a dose-response curve for spike frequencies using the “Spike_ 
frequency_analysis(_filter)” workflow template in which this module is included. 

If you would like to add this module to your own analysis workflow, please refer to the step1-2 at the 
section 3-2. Drug testing on pages 57-58. (If you added phase bars while recording, the location of the 
phase bars were saved to your analysis workflow.)

1. Set the all analysis parameters according to the previous section 3-3.2 Analyzing the spike rate. 
(Pages 64-66)

2. Open the “Spike” tab and replay data by clicking the Green button.The first phase (baseline) will 
start from 0. 

3. When the first phase is finished, pause Mobius with the YELLOW 
button. Click [Annotations] > [Add New phase]. Type in the name 
for the 2nd phase. (Fig. 3-3.18) 

When the OK button is clicked, the yellow bar with its name 
appears on the Spike Frequency chart (Fig.3-3.19).

*NOTICE: If Mobius is stopped with the Black button, replaying is 
terminated and a phase bar can not be added.

4. Start Mobius by clicking the Green button again. When the 2nd phase is finished, pause Mobius with 
the YELLOW button and make a new phase.

5. Replay the data to the end. Averages and standard deviations are computed and graphed for each 
phase (dose) in the [Compute Measure Averages] module in the “Average” tab.(Fig.3-3.15)

6. The phase annotations (yellow bars) can be shifted by clicking and dragging. The averages and 
standard deviations are recalculated once Mobius is run with the Green or Green-Red button after 
changing the locations of phase bars.

7. If you are satisfied with the location of the phase bar, save it as your own analysis workflow. 
(Refer to page 47)

8. In order to save the average chart to a "CSV" file, check the check-box for the [Save Measures 
Averages] module, then run Mobius with the GREEN-RED button.

Fig.3-3.18.  
 

Adding a new phase.

Fig.3-3.19. The added new phase (dose 1).
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Input fields for [Compute Measure Averages] module

1. Channel: The channel to be displayed is selected here. Channels can NOT be changed during replay.

2. Use last: When this box is checked, the selected (or typed) number of data points are used for 
computations. For example, if 10 is selected, average and standard deviation are measured for the 
last 10 traces in each phase.

3. Hide: hides the measurement checked in the chart.

• Note: the chart can be zoomed up or down by clicking and changing numbers of the maximum 
and/or minimum scale(s) for both X and/or Y axis.

Fig.3-3.20. [Display Spike Measures] module with phase annotation bars (top) and the graphs for averages and  
standard deviations in the [Compute Measure Averages] module (bottom).
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3-3. Replay and analysis of acquired data

3-3.4. Spike sorting (clustering)

The purpose of sorting (clustering) spikes is to identity and separate signals referred from multiple cells 
acquired on a single channel (electrode) based on their waveforms. 
This section will teach you how to sort (cluster) spikes and analyze the spike frequency using the 
“Spike_sorting(_filter)” workflow template. This template include following modules in the tabs of 
“Main”, “Spike”, and “Filter”

Replayed signals are filtered with the selected flitter menu, and then sent to the [Extract Spikes] mod-
ule. Spikes crossing the pre-defined thresholds are extracted and sorted based on the waveform 
shapes. Clustered spikes’ frequencies are computed and graphed. Raw data can be exported to binary 
or ASCII (“CSV” format text) file. Extracted spike waveforms, time stamp, spike centroids and spike 
frequency charts can be saved as “CSV” format text file.

With the “Spike_sorting” workflow template, the replayed data is not filtered but sent directly to the 
[Extract Spikes] module.

Tab Modules

Main Replay Raw Data File / Export Raw Data

Spike
Extract Spikes / Save Spikes / Cluster Spikes / Compute Spike Freqs /
Save Spike Freqs

Filter
Filter Raw Data (2) / Display Single channel (showing original data) /
Display Single channel (showing filtered data)

Fig.3-3.21. Module configuration for the “Spike_sorting_filter” workflow template.

“Main” tab

“Spikes” tab

“Filter” tab
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1. Select the filter menu

Open the data file and replay the data with the Green button. Change the filter menu accordingly.

• The top chart displays the raw data and the bottom chart displays the filtered data.The ampli-
tude (Y axis) can be changed by clicking and typing values in the maximum and/or minimum 
amplitude.

• The time (X axis) can be changed by selecting numbers in the “Duration” drop down menu. 
The maximum duration is 10 msec

Fig.3-3.22. Control panels on the “Spikes” tab in the “Spike_sorting_filter” workflow template. Refer to Fig.3-3.3

Extract Spikes Cluster Spikes Compute Spike Freqs
Save Spike Freqs

 Save Spikes

Display Spike Measures

1. Spikes are extracted 

Time course of spike 
   frequency (bottom)

 are displayed.

 (top-left)
2. Waveforms of extracted

spikes (top-right)

 3. 

for control panels in the “Main” tab and Fig.3-3.23 for the “Filter” tab.
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2. Set the thresholds

Click on the “Spike” tab. Set the thresholds and 
Pre/Post times for spike extraction depending on the 
sizes of spikes.

The thresholds are displayed on the top-left chart in 
the [Display Spike Measures] module.

 

1)  Change the values for thresholds by double clicking and typing 
values directly into the [Extract Spikes] module chart. 
(Fig.3-3.25)

2)   The thresholds and Pre/Post times can be applied to all channels 
by right-clicking and selecting Apply to All. (Fig.3-3.26)

• Please refer to Mobius User Guide (5.2.3 Extract Spikes) for 
details on thresholds and pre/post times.

• Disable button: 
When this check box is checked, spikes are NOT extracted. 

• Channel limit selector: 
The maximum numbers of spikes to be extracted per 1 second at a channel can be limited 
here. (This is used mostly for acquisition.)

  shows the raw data and bottom chart shows filtered data.
  Fig.3-3.23. Control panels for the “Filter” tab in the “Spike_sorting_filter” workflow template. Top chart 

Select 

filter menu

 

Change the duration
(Scale for X axis)
with this drop-down
menu

Fig.3-3.24. Extract Spikes module.

Fig.3-3.25.

Fig.3-3.26.
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3. Set the menu for spike sorting (clustering)

As mentioned above, the purpose of sorting (clustering) spikes is to identify and separate signals 
referred from multiple cells acquired on a single electrode based on their waveforms.

The sensitivity of the clustering process is changed using (1) Similarity Radius and (2) Min # spikes 
parameters.

The default setting are 30% for the Similarity 
Radius and 5 is for Min # spikes. This means: 
when spikes with waveform similarity higher 
than 30% are proceeded 5 times, a valid cluster 
is identified and its centroid (an “average” spike 
shape) is determined. 

Spikes not assigned to any cluster are not color 
coded. They will remain green until there are 5 
spikes with similar waveforms.

Extracted spikes are assigned to a Cluster 
(A,B,C, etc) if their similarity is higher than 
30% to the Cluster’s centroid. Spikes with less 
than 30% similarity to the centroid will remain green. Un-assigned spikes will be assigned as NC in 
the saved data.

Each Cluster (A,B,C, etc in the Mapping chart) has different color code (e.g. A with red) and its 
waveforms and frequency are displayed with the same color code on the charts in the [Display Spike 
Measures].

These parameters can be modified to establish valid sets of clusters.

(1) Similarity

This parameter determines how sensitive the sorting (clustering)  is to variations in spike 
waveforms. 

Larger numbers  >  more sensitive to spike shape variations > produce FEWER clusters. 
Smaller numbers > less sensitive to spike shape variations   > produce MORE clusters 

(2) Min # spikes

This determines how many spikes need to come to be recognized as a Cluster. 
Increasing this value means FEWER clusters.

After replaying data to determine 
centroids, you may see that different 
clusters (e.g. C and D) really represent the 
same cell and you may want to merge 
them. Change the Cell number for Cluster 
D to 3 by double-clicking and directly 
typing in this number so that the Cluster D 
is merged to the Cluster C. (Fig.3-3.28)

(1)

(2)

Fig.3-3.27. Cluster Spikes module.

Fig.3-3.28. Merging Cluster D and C.
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For another example, you may see that 
Cluster E is probably just noise and you 
want to remove it from your analysis. In this 
case, you can delete this cluster by deleting 
the number at the Cell column. (Right click 
the Cell number, then select Delete.) 
(Fig.3-3.29)

Those changes can be reset by clicking 
[Reset Mapping] button.

Once you have a valid set of Clusters that you believe represent different cells, you can freeze them 
by checking the [Freeze centroids] check-box. This means that incoming spikes will NOT alter the 
definition of the existing clusters (their centroids), nor cause new clusters to form.

Centroids must be frozen to be definitely established. Otherwise, centroids are changing whenever 
new spike is assigned to a cluster.

4. Display Spike Measure charts

In the [Display Spike Measures] control panel, the 
top-left chart shows that spikes are extracted, the 
top-right chart shows extracted spikes’ waveforms, 
and the bottom chart shows spike frequency. The 
waveforms and time course of spike frequency are 
color coded according to cluster since this module is 
under [Cluster Spikes] in the “Spike_sorting(_filter)” 
workflow template. (Refer to Fig.3-3-32)

In the Extracted Spikes chart, you will see wave-
forms with solid lines and ones with dot lines. The 
waveforms with solid lines are the centroid wave-
forms and the dotted lines are extracts spikes’ wave-
forms (Fig.3-3.30). Spikes NOT assigned to any Cluster are displayed in green. (Refer to page 66 
for modifications for these charts.)

5. Compute spike frequencies 

Spike frequency is calculated every second in the default settings. 
This can be changed by selecting different value for “Arbitray(s)” on 
the [Compute Spike Freqs] module. When “Trace” is selected, the 
whole trace’s spikes are counted.

In the “Spike_sorting(_filter)” workflow template, this module is 
under the [Cluster Spikes] module. Spike frequencies for all Clusters 
(clustered spikes) will be color coded and displayed in the spike frequency chart.

The frequency calculations are reset when the number of clusters changes during replay. The fre-
quency chart is reset whenever a new Cluster is formed. When the check box for [Freeze Centroids] 
is checked, now the numbers of cluster are fixed and frequency calculations are not reset anymore. 

The [Freeze Centroids] check box must be checked, when the Spike frequency chart is saved.

Fig.3-3.29. Deleting a Cluster.

Fig.3-3.30. Extracted spikes.
    Solid lines show centroid waveforms. 

                        Dot lines show extracted spikes’ waveforms.

Fig.3-3.31.
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6. Run the workflow again by clicking the Green button to make sure that you are satisfied with valid 
clusters and all other analysis parameters, and then stop it. Save it as your own analysis workflow. 
The output will be the data you have selected.

Fig.3-3.32. Spike sorting.
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Data Output

Now, you are ready to generate data. When the analysis workflow is run by licking the GREEN-RED but-
ton with the boxes for the Save or/and Export modules checked, the data are saved and/or exported. 

Channels for the Saving/Exporting are selected with the channel selector in the [Replay Raw Data] 
module. Channels shown with green color will be saved. File names for all Save/Export modules can be 
modified by typing directly them into the Filename box. 

1. Export raw data

The [Export Raw Data] module is used. The raw data (waveforms) are exported either as 1) Binary 
shorts (2 byte integer values), 2) Binary doubles (8 byte floating point values), or 3) ASCII text in 
“CSV” format. 

File Format 20071201
Session St 2010/8/11 19:03:39 +09

time_ms  ch1_mV  ch2_mV  ch3_mV  ch4_mV  ch5_mV  ch6_mV
0 0.000488 -0.00049 -0.02002 -0.00244 -0.00049 -0.00098

0.05 0.000977 -0.00293 -0.01953 -0.00244 0.000977 0
0.1 0.000488 -0.00391 -0.01807 -0.00439 -0.00049 0.000977

0.15 0.001465 -0.00342 -0.01465 -0.00537 -0.00146 0.000488
0.2 0.002441 -0.00342 -0.00879 -0.00439 -0.00244 0.001465

0.25 0.001953 -0.00195 -0.00439 -0.00293 0 0.00293
0.3 0.001465 -0.00146 -0.00146 -0.00195 0.001953 0.00293

0.35 0.001465 -0.00146 0.000977 -0.00146 0.000977 0.002441
0.4 0.001953 -0.00244 0.001465 -0.00098 -0.00146 0.001465

0.45 0.001953 -0.00195 0.002441 -0.00049 -0.00293 0.000977
0.5 0.002441 -0.00195 0.000488 0.001465 -0.00391 0

0.55 0.001465 -0.00195 0.002441 -0.00049 -0.00439 0
0.6 0.000977 -0.00293 0.002441 -0.00195 -0.00391 0

0.65 0 -0.00391 0.002441 -0.00244 -0.00391 0
0.7 0.000488 -0.00391 0.001465 -0.00293 -0.00293 -0.00098

0.75 0.001465 -0.00293 0.000977 -0.00195 -0.00049 -0.00244
0.8 0.001953 -0.00342 0.001465 -0.00098 0.000977 -0.00537

0.85 0.001465 -0.00342 0.00293 -0.00146 0.000977 -0.00537
0.9 0.000977 -0.00293 0.005859 -0.00195 0.000488 -0.00537

0.95 -0.00146 -0.00195 0.005859 -0.00244 -0.00049 -0.00439

Fig.3-3.33. Example of raw data exported as ASCII displayed in Excel.
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2. Save extracted spikes and time stamps 

The [Save Spikes] module is used.

1)   Time stamps only, or 

2)   Time Stamps and waveforms of all extracted spikes (shown with dot line at the [Display Spike 
Measure] chart) are saved as a “CSV” formatted text file.

•  In the “Spike_sorting(_filter) “ workflow template, the [Save Spikes] modules is under [Clus-
ter Spikes]. The time stamp and spike waveforms will have cluster IDs in the saved file.

• The Centroids MUST be frozen for the data saved correctly.

3. Save Centroids 

The [Cluster Spikes] module is used. The centroid waveforms (shown with solid line at the [Display 
Spike Measure] chart) are saved as a “CSV” formatted text file. 

•  The Centroids MUST be frozen for the data saved correctly. 

File Form 20071201
Session 2010/8/11 19:03:39 +09:00
Trace Du 10252

channel  time_of_day
 
within_session_ti
me

 
within_se
ssion_tim
e_ms

 
within_trac
e_time_ms

 
cluster
_id

 
trace
_num

 
pre_
ms

 
post_
ms

 y0_mV  y1_mV

1  19:03:39.221  0d:00:00:00.221 221.4 221.4 1 1 1 2.5 0.00913 0.00948
1  19:03:39.271  0d:00:00:00.271 271.25 271.25 1 1 1 2.5 0.006259 0.005788
1  19:03:39.344  0d:00:00:00.344 344.55 344.55 1 1 1 2.5 0.002066 0.002188
2  19:03:39.19  0d:00:00:00.19 190.85 190.85 1 1 1 2.5 0.003162 0.003685
2  19:03:39.282  0d:00:00:00.282 282.2 282.2 1 1 1 2.5 -0.00199 -0.00099
3  19:03:39.021  0d:00:00:00.021 21.3 21.3 1 1 1 2.5 0.002024 0.002668
3  19:03:39.292  0d:00:00:00.292 292.05 292.05 1 1 1 2.5 -0.0154 -0.01643
5  19:03:39.177  0d:00:00:00.177 177.35 177.35 1 1 1 2.5 0.005864 0.006522
5  19:03:39.217  0d:00:00:00.217 217.35 217.35 1 1 1 2.5 0.002684 0.003227
5  19:03:39.351  0d:00:00:00.351 351 351 1 1 1 2.5 0.00163 0.002463
6  19:03:39.461  0d:00:00:00.461 461.75 461.75  none 1 1 2.5 0.001753 0.001386
6  19:03:39.468  0d:00:00:00.468 468.9 468.9 1 1 1 2.5 0.004138 0.005201
6  19:03:39.472  0d:00:00:00.472 472.9 472.9  none 1 1 2.5 -0.00232 -0.00321
6  19:03:39.485  0d:00:00:00.485 485.8 485.8 1 1 1 2.5 0.004636 0.004055
6  19:03:39.492  0d:00:00:00.492 492.85 492.85 1 1 1 2.5 -0.00255 -0.00276
7  19:03:39.437  0d:00:00:00.437 437.75 437.75 1 1 1 2.5 0.003172 0.001977
9  19:03:39.006  0d:00:00:00.006 6.6 6.6 1 1 1 2.5 0.005892 0.004139
9  19:03:39.011  0d:00:00:00.011 11.85 11.85 1 1 1 2.5 -0.00646 -0.00638
9  19:03:39.056  0d:00:00:00.056 56.6 56.6 2 1 1 2.5 0.003823 0.00482
9  19:03:39.073  0d:00:00:00.073 73.85 73.85 2 1 1 2.5 -0.00664 -0.00679
9  19:03:39.113  0d:00:00:00.113 113.65 113.65 1 1 1 2.5 -0.00189 -0.00076

Fig.3-3.34. Example of Time Stamps and Waveforms saved as a “CSV” file displayed in Excel. Each Time Stamp and 
          Waveform has cluster ID.
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4. Save the spike frequency data 

The [Save Spike Freqs] module is used. The spike frequency data is saved as a “CSV” formatted text 
file.

• In the “Spike_sorting(_filter)” workflow template, [Compute Spike Freqs] module is under 
[Cluster Spikes] module. The spike frequency chart for spikes with cluster ID (C1, C2) will be 
saved.

• The Centroids MUST be frozen for the data saved correctly.

CHANNEL 1
#Centroids 2

Centroid 1
sign -1
ms mV

0 0.0017
0.05 0.0051
0.1 0.0057

0.15 0.0064
0.2 0.0071

0.25 0.0077
0.3 0.0081

0.35 0.0083
0.4 0.0085

0.45 0.0087
0.5 0.0085

0.55 0.0075
0.6 0.0053

0.65 0.0017
0.7 -0.0031

0.75 -0.0088
0.8 -0.0151

0.85 -0.0215
0.9 -0.0272

0.95 -0.0313
1 -0.0332

1.05 -0.0331
1.1 -0.0311

1.15 -0.0279
1.2 -0.0239

1.25 -0.0198
1.3 -0.0157

1.35 -0.0116

Fig.3-3.35.

 Left: Example of the centroids saved as a “CSV” file displayed in Excel.
Right: Example of the spike frequency data saved as a “CSV” file displayed
in Excel. Centroids for channel 5 are saved.

File Format 20071201
Session St 2003/12/15 18:13:29 +09

time_secs phase  ch5  ch5  ch5  ch5
  NC  C1  C2  C3

1 Baseline 0 6 1 1
2 0 13 0 2
3 0 1 0 0
4 0 17 0 2
5 0 2 0 0
6 0 9 1 3
7 0 4 0 0
8 0 11 1 1
9 0 3 0 0

10 0 9 0 5
11 0 7 0 0
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4-1. Recording of spontaneous myocardial signals

Chapter 4         Mobius QT 

This chapter describes how to record and analyze signals from cardiac myocyte cultures, acute heart 
tissue, or stem cell derived cardiac myocytes using available workflow templates. 

4-1. Recording of spontaneous myocardial signals

There are 3 workflow templates available for recording spontaneous myocardial signals. 

1. Simple_recording: 
    For recording myocardial signals (long spikes) WITHOUT any on-line (real-time) analysis.

2. Beat_recording:  
    For recordings with extracting myocardial signals (long-spikes), and measuring their
    frequencies and inter-spike intervals.

3. QT_recording:
    For recordings with extracting myocardial signals (long-spikes), measuring their
    frequencies and inter-spike intervals, and analyzing extracted waveforms.

After reading this section you should be able to record spontaneous myocardial signals using any of the 
above workflow templates. 
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4-1. Recording of spontaneous myocardial signals

4-1.1. Overview of the recording workflow templates

“QT_recording” workflow template

The "QT_recoding" workflow template consists of following modules located in the “Main”, “Detect beat-
ing”, and “Measurement” tabs.

With this workflow template, spikes (myocardial signals) crossing pre-determined thresholds are 
extracted. The extracted long spikes are filtered according to the selected drop down filter options in 
the [Filter Spike Data] module, and then sent to the [Extract Spike Measures] module, where a variety 
of analyses can be performed and graphed (e.g., amplitude, slope, area, and peak to peak time etc. ). 
The beat frequency of the extracted long spikes are also computed and graphed. Use this workflow 
template if your interest is waveform analysis including field potential duration (FPD) for studying QT 
prolongation.

Tab Modules

Main Acquire MED64 Data / Display All Channels  

Detect beating
Extract Long Spikes  /Display Extracted Spikes / Com pute Beats  per Minute / Display
Beats  per Minute

Measurem ent
Filter Spike Data (2) / Extract Spike Measures  / Save Measures  Data / Display Results
Table

“Main” Tab

 “Detect beating” Tab

“Measurement” Tab

Fig.4-1.1. Module configuration for  the “QT_recording” workflow template.
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4-1. Recording of spontaneous myocardial signals

Acquire MED64 Data Extracted Long Spikes

Display All Channels

Fig.4-1.2. Control panels for the “QT_recording” workflow template. “Main” tab (top-left), “Detect beating” tab ,

Compute Beats per Minute

Save Beats per Minute

  Display  Extracted Spikes 

Display Beats per Minute 
Filter Spike Data

Save Measures Data

Extract Spike Measures

Display Results Table

(top-right), and “Measurement” tab (bottom).
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 “Beat_recording” workflow template

The “Beat_recording” workflow template consists of following modules located in the “Main” and 
“Detect beating” tabs.

With this workflow template, long spikes (myocardial signals) crossing pre-determined thresholds are 
extracted, and their beat frequencies (beats per minute) and interspike intervals are measured and 
graphed. Use this template if your interest is beat frequency.

“Simple_recording” workflow template

 Signals are acquired, and the acquired signals are dis-
played at all 64 channels. 

Tab Modules

Main Acquire MED64 Data / Display All Channels 

Detect beating
Extract Long Spikes / Compute Beats per Minute / Save Beats pre Minute /Display Beats
per Minute /  Compute Interspike Intervals / Save Interspike Intervals / Display Interspike
Intervals / Display Extracted Spikes

“Main” tab

“Detect beating”
tab

Fig.4-1.3. Module configuration for the “Beat_recording” workflow template.

Fig. 4-1-5. Module configuration for the “Simple_
recording” workflow template.
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Opening the workflow template

1. Click [Workflow] > [New] > [From 
Template]. (Fig.4-1.6)

2. Select [SU-MED640_1280x1024] 
folder. Select [QT] > 
[Spontaneous_recording] folder, and 
then any of the recording workflows.

    

Acquire MED64 Data Extract Long Spikes

Display All Channels

Display Beats per Minute

Display Interspike Invervals

  Compute Beats per Minute (top) 

Save Beats per Minute (bottom)
Compute Interspike Intervals (top)
Save Interspike Intervals (bottom)

Display Extracted Spikes 

Fig.4-1.4. Control panels for the “Beat_recording” workflow template. “Main” tab (left) and “Detect beating” tab
(right).

Fig.4-1.6. Opening workflow template.
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4-1.2. Setting the acquisition parameters

All the recording workflow templates include the [Acquire MED64 Data] module. Acquisition parameters 
are set in this module. 

(1) # Traces: Number of Traces (sweeps).

(2) Auto-pause:  

Mobius will pause automatically when the current trace is finished if this box is checked. The trace 
interval set below becomes invalid when this box is checked. Mobius re-starts by clicking either of 
Green button or Green-Red button.            
      

(3) Trace duration: Sampling (Recording) time for each trace.

(4) Trace interval:

Interval between traces. (from the beginning of the first trace to the beginning of the next trace.)
• Signals are recorded for 2 minutes every 3 minutes 5 times in the default setting as seen in 

the following figure. Mobius will run for 15 minutes total.

•  The trace interval becomes invalid when Auto-pause is checked.  
 

(5) Range (V):

Maximum input signal level. This setting should be adjusted according to the signal amplitude to 
achieve the maximal dynamic range.

(6) Low cut freq (Hz):

High pass filter: Select 0.1, 1.0, 10 or 100 Hz. If 1Hz is set, the signals with frequencies lower than 
1 Hz are filtered out. 1Hz is recommended for the recording of myocardial signals.

(7) Channels:

Select the channels for recording here. When the square box is clicked, the channel selector pops up. 
The enabled recording channels are colored green.

(1)

(3)

(4)

(5)

(6)

(7)

(8) Fig.4-1.7.  [Acquire MED64 Data] module.

(2)

2 min.

3min.

2 min.

Recording
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(8) Save raw data:

When Mobius is started by clicking the Green-Red recording button while the [Enable storage] is 
checked, the raw data is saved. The file name can be modified.

4-1.3. Execution button

The workflow template is run and stopped (paused) with the following execution buttons.

                                             Fig.4-1.8. Execution buttons.

4-1.4. Before starting your experiment

When the Mobius is run for the first time after turning on your MED64PC, it will take some time for sig-
nals to appear on the screen as the baseline is zeroed at all 64 channels. Before you start your experi-
ment, run Mobius with Green button and make sure that the baselines at all 64 channels stabilize 
around 0 V.

When you run workflow including [Extract Long Spikes] for the first time after turning on your MED64 
PC, check “Disable” at the [Extract Long Spikes] module so that signals are NOT extracted, then run 
workflow. Otherwise, Mobius might crash trying to extract irregular signals.

           

          Stop                 Run WITHOUT        Run WITH        Pause
                               saving data             saving data
 

Fig.4-1.9. Unstable baseline (left) and stable baseline (right).
Run Mobius while checking the “Disable” button (bottom-left) so that 

 signals are not detected.
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4-1.5. Recording spontaneous cardiomyocyte signals

CAUTION:

• Make sure that the hard disc drive has enough free space when you start long-term recording. 
Recording with all 64 channels for 1 hour creates a 9.216GB file. 
(9.216GB is 9,000,000KB, 8,739.06MB, or 8.58GB in Windows.)

• Avoid saving data to the drive where the OS is installed (usually C drive). Save it to a separate hard 
drive in the following cases:
1) When trace duration is set to longer than 30 minutes. 
2) When trace duration is set to longer than 5 minutes and # Traces is greater than 12.

• Extraction of long spikes and following analysis require powerful computation and need to be used 
carefully during acquisition. Mobius can appear to crash when it extracts more spikes than it can 
analyze/display. This most often happens when there is noise or baseline fluctuation that crosses 
the spike extraction thresholds on all channels at once. (e.g. unexpected noises cross the thresh-
olds or the baseline fluctuates due to vibration.)

•  It is strongly recommended you start your new experiments WITHOUT on-line (real- time) analy-
sis (by disabling the spike detection).

1. Modify the #Traces, Trace duration, and Trace interval in the [Acquire MED64 Data] module. (Refer 
to page 86, section 4-1.2. Setting the acquisition parameters.)

2. Open the “Detect beating” tab. Check the “Disable” box so that 
myocardial signals (long spikes) are NOT extracted. 
(Fig.4-1.10)

• When this button is checked, no long spikes’ extractions or   
analysis can be displayed during recording.

3. Run Mobius by clicking the Green button, and then stop.

4. Select the channels for recording.

1) Click the box next to the “Channels” in the [Acquire MED64 Data] module 
to open the channel selector. (Fig.4-1.11)

2)  The recording channels are colored green and non-recording channels are 
colored red.

5. Open the “Main” tab. Make sure “Enable storage” is checked in the Save raw 
data . 

6. Save it as your own recording workflow by clicking [Workflow] > [Save 
as]. (Fig.4-1.12)

7. Start Mobius with GREEN-RED button.

• Mobius will require you to save the workflow as your own if you try 
to start Mobius with the Green-Red button without having saved it 
already.

Fig.4-1.10. Disable button.

Fig.4-1.11. 
Channel selector.

Fig.4-1.12.
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• The data file (.modat file) and the Analysis workflow (including all analysis module selected for 
the Recording workflow and [Replay Raw Data File] module will be saved in the same folder.

8. Signals are displayed via the [Display All Channels] module and "Trace 1" chart in the [Display 
Extracted Spikes] module. However signals or analysis are NOT displayed in other modules. (Fig. 
4-1.13)

 
Recording myocardial signals with on-line (real-time) analysis

When the “Disable” button is unchecked, the acquired signals crossing pre-determined thresholds are 
extracted and analyses are performed on-line (during recording.) The extraction of long spikes and 
their analysis require powerful computation and can slow down Mobius' data processing. Mobius can 
appear to crash. When this workflow is used with on-line analysis, please follow the notices below.

• Select just ONE channel for the acquisition when the "QT_recording" workflow template (or 
any workflow including [Extract Spike Measures]) is used.

(You can select more channels for the acquisition with the "Beat_recording" workflow template 
or workflows including [Beat frequency] and [Interspike intervals], but not with [Extract Spike 
Measures]).

• Avoid enabling any [Export] or [Save] modules when raw data is saved. Once raw data is 
saved, you can export during off-line analyses.

• Set the trace time (recording time) to less than 10 minutes and trace intervals to longer than 
the trace time. Particularly, keep the trace time short for long-term recordings lasting days, 
weeks, or months

• Set the thresholds as low as possible for negative signals (high for positive signals) so that 
other components of the signals or noise are NOT extracted as spikes.
 

• Make sure to pause Mobius with the yellow button when a drug is applied.

Please refer to section 4-3.2. Field potential duration analysis (page 102-) for instructions on how 
to set analysis parameters.

Fig.4-1.13. Disabling the spike extraction (left) and recording without spike extraction (right). 
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4-2. Drug testing

The [Compute Measure Averages] module calculates averages and standard deviations for the wave-
form analysis (Extract Spike Measures), beat frequencies, and interspike intervals for all the experi-
ment's phases. This is a useful tool for making a dose-response curve or comparing phases before, 
during and after drug application. This section will demonstrate how to add "phase bars" so as to make 
a dose-response curve easily and quickly off-line.

1. Open the “QT_recording” or “Beat_recording” workflow template.

2. Set the acquisition parameter and check the “Auto-pause” check box. 
(Fig.4-2.1) Acquisition will be PAUSED automatically after each trace 
recording is finished. 

3. Set the analysis parameters (refer to page 102-107). Save it as your 
own workflow. ([Workflow] > [Save as])

4. Open the Detect beating tab. Start recording in Mobius with clicking 
GREEN-RED button. The first phase (baseline) will start from time 0.

5. When the first phase is finished, Mobius pauses automatically.

•  If the “Auto-pause” check box is NOT checked, pause Mobius by 
clicking YELLOW button. 

• Do NOT stop with Black button. If it is stopped, the experiment will end and new phases will 
not be added.

6. Apply the drug during the “pause”. Click 
[Annotations] > [Add New phase]. Type the 
name for the 2nd phase. (e.g. 100nM E4031) 
(Fig.4-2.2) 

When the OK button is clicked, a yellow bar 
with the chosen name appears. This can be 
done in modules such as [Extract Spike Mea-
sures], [Display Beas per Minute], and/or 
[Display interspike intervals]. (Fig.4-2.3)

7. Re-start Mobius by clicking GREEN-RED but-
ton.

8. When the 2nd phase is finished, Mobius 
pauses automatically again. (Or pause Mobius 
manually by clicking the Yellow button.) 

9. Click [Annotations] > [Add New Phase], then 
type the name for the third phase. (e.g. 
1000nM E4031)

10. Re-start Mobius with GREEN-RED button and 
run Mobius to the end of experiment. (or add 
subsequent phases with same procedure and 
run Mobius to the end of experiment.)

Fig.4-2.1.

Fig.4-2.2.

Fig.4-2.3. Phase bar on the [Extract Spike Measures]
control panel.
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11. The Fig.4-2.4 shows the [Extract Spike Measures] module with added phase bars.
 

12. The analysis workflow including all analysis parameters and phase bars you set are automatically 
made in the same directory as the acquisition workflow. Use this analysis workflow to make a 
dose-response-curve later off-line. (Refer to page 110-112 for detailed instructions on how to make 
a dose-response-curve.)

The phase bars can be added and saved to the analysis workflow even without extracting long spikes. 
(Signals and analysis are not seen during recording in this case.) It is still recommended to perform 
experiments without spike extracting unless you are very familiar with your experiment and prepara-
tions.

Fig.4-2.4. The [Extract Spike Measures] module with phase bars.
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4-3. Replay and analysis of acquired spontaneous data

Mobius data files (.modat) are opened and replayed with the [Replay Raw Data File] module, and ana-
lyzed using modules such as [Compute Beat Frequency], [Compute Interspike Intervals], and [Extract 
Spike Measures]. You will design your Analysis workflow by combining those modules for replay and 
analysis of the acquired data. The quickest way to replay and analyze the data is using the Analysis 
workflow templates, which will be introduced in this chapter.

The following analysis workflow templates are available for analysis of spontaneous myocardial data:

1. QT_analysis:
Workflow for waveform analysis including field potential duration analysis (measurement).

2. Beat_frequency_analysis:
Workflow for signal frequency analysis.

3. Export_for_propagation_analysis_spontaneous:
Workflow for making a propagation map.

The Analysis workflow with the [Replay Raw Data File] and the analysis modules you selected for your 
recording will be automatically saved to the same directory when you record with the Green-Red but-
ton. These workflow templates can also be used for quickly performing analysis.

4-3.1. Replaying acquired data

1. Open the analysis workflow.

Click [Workflow] > [New] > [From Tem-
plate].

Select [SU-MED640_1280x1024] > [QT] > 
[Spontaneous_analysis] folders, then select 
a workflow template.  

In order to open your own analysis workflow, 
click [Workflow] > [Open]. Select the analy-
sis workflow file (.moflo file).                      

2. Click the box next to the “Filename” and select the .modat file. When the file name appears in the 
box (as seen on the left figure of the Fig.4-3.2), the data is ready to be replayed by clicking the 
Green or Green-Red button.

• Opening large size of data takes several minutes. (e.g. Opening 10GB data takes over 1 min-
ute.) 

Fig.4-3.1. Opening analysis workflow template.
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3. When the Green button is clicked, the acquired data is just replayed. Clicking the Green-Red button 
while checking the “Enable” check-box executes the Export or Saves.

 

Input fields for the [Replay Raw Data File] module

1. Traces: Selects the trace(s) for processing.
2. Trace time: Selects the trace time for processing.
3. Channels: Selects the channels for processing. Click the box next to the “Channels” to open the 

channel selector. Channels in green will be enabled.
4. Delay: Set this value to a value greater than zero to insert a delay between data “blocks” sent out 

by this module. It is useful for slowing down data processing. 

2

Fig.4-3.2. Opening a Mobius data file (.modat file).

Fig.4-3.3.  Replayed spontaneous myocardial data. 
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4-3.2. Overview of the analysis workflow template

This section provides an overview of the workflow templates available for analysis of spontaneous myo-
cardial signals. 

 “QT_analysis” workflow template

Use this workflow template for waveform analysis of the extracted myocardial signals (long-spikes) 
including field potential duration analysis. This workflow template consists of the following modules 
located in the “Main”, “Detect beating”, “Measurement”, and “Averages” tabs. Please refer to section 
4-3.2 on field potential duration analysis. (page 102-107)

The replayed raw data is sent to the [Extract Long Spikes] module where long spikes crossing 
pre-defined thresholds are extracted. The extracted long spikes are filtered, and then sent to the 
[Extract Spike Measures] module where their amplitude, slope, time, or area is measured and graphed. 
The [Display Results Table] shows the values for the analyses performed with the [Extracted Spike Mea-
sures].

The [Compute Measure Averages] module computes and graphs the averages of the waveform analy-
sis. The extracted long spikes are sent to [Compute Beat per Minute] module for their frequencies to be 
measured as well.

Raw data can be exported as a binary or ASCII ("CSV" formatted text file). The measurement chart and 
average chart can be saved as "CSV" formatted text file. 

Tab Modules

Main Replay Raw Data File / Dis play All Channels  / Export Raw Data

Detect beating
Extract Long Spikes  / Dis play Extracted Spikes  / Com pute Beats  per Minute / Save Beats
per Minute / Dis play Beats  per Minute

Meas urem ent
Filter Spike Data (2) / Extract Spike Meas ures  / Save Meas ures  Data / Dis play Res ults
Table (for Eextract Spikes  Meaus res )

Averages
Com pute Meas ure Averages  (for Extract Spike Meas ures )  / Save Meas ure Averages  (For
ESM)

“Main” tab

“Detect beating” tab

“Measurement” tab

“Averages”  tab

Fig.4-3.4. Module configuration for the “QT_analysis” workflow template.
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Extract Long   Compute Beats 
        per Minutes

   Save Beats
        Minutes

                 

Display Extracted
Spikes

                    

Compute Measure

Save Measures

Fig.4-3.5. Control panels for the “QT_analysis” workflow template. “Detect beating” tab (top), “Measurement” tab

         per  

Display Beats
per Minute

Averages 
(for Extract Spike Measures)

Filter 
Spike Data

Extract Spike
Measures

Data

Display Results
Table

Save Measure
Averages

  (middle), and “Averages” tab (bottom). 

Spikes
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“Beat_frequency_analysis” workflow template

Use this workflow template if your interest is beat frequency analysis. The "Beat_frequency_analysis " 
workflow template consists of following modules located in the “Main”, “Detect beating”, and “Averages” 
tabs. Please refer to section 4-3.3, Beat frequency analysis (page 108-109) for instructions on how to 
use this workflow template.

The replayed raw data is sent to the [Extract Long Spikes] module in which long spikes crossing 
pre-defined thresholds are extracted. The extracted long spikes are sent to the [Compute Beats per 
Minute] module for measuring their frequencies as well as [Compute Interspike Intervals] module for 
measuring interspike intervals. The [Compute Measure Averages] module computes and graphs the 
averages of the interspike intervals.

The raw data can be exported as Binary or ASCII ("CSV" formatted text file). The beat frequency chart, 
inter-spike-interval chart, and averages chart can saved as a "CSV" formatted text file.

Tab Modules

Main Replay Raw Data File  / Display All Channels / Export Raw Data

Detect beating
Extract Long Spikes 　/ Display Extracted Spikes / Compute Beats per Minute / Save Beats per
Minute / Display Beats per Minute / Compute Interspike Intervals / Save Interspike intervals /
Display Interspike Intervals

Averages Compute Measure Averages (for Beat frequency)  / Save Measures Averages (For BF)

“Main” tab

“Detect beating” tab

“Averages” tab

 
 

Fig.4-3.6. Module configurations for the “Beat_frequency_analysis” workflow template.
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Extract Long Spikes

Compute Beats 

Save Beats 

Compute 

Save Interspike

per Minute

per Minute

Interspike intervals

intervals

Display Beats
per Minute

Display 

Display Interspike 
Intervals

Display Extracted
Spikes

Compute Measure
Averages (for ISI)

Save Measure
Averages

Fig.4-3.7. Control panels for the “Beat_frequency_analysis” workflow template. “Detect beating” tab (top)

                       

 (for ISI)

and “Averages” tab (bottom). 
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“Export_for_propagation_ analysis_spontaneous” workflow template

This workflow template allows you to export the time stamps of the extracted long spikes with a “CSV” 
file. This is useful for creating a propagation map. It consists of following modules located at 3 Tabs. 
Please refer to section 4-3.6. Propagation analysis for spontaneous data (page 113) for instruction on 
how to use it.

The replayed raw data are filtered, and then sent to the [Extract Long Spikes] module, in which long 
spikes crossing pre-defined thresholds are extracted. The [Save Spikes] module allows you to save the 
Time Stamps of the extracted long spikes as a “CSV” file.

Tab Modules

Main Replay Raw Data File / Display All Channels

Filter Filter Raw Data (2) / Display All Channels

Detect beating Extract Long Spikes  / Save Spikes  / Extract Spike Measures

Fig.4-3.8. Module configurations for “Export_for_propagation_analysis_spontaneous” workflow template.

“Main” tab

 “Filter” tab

“Detect beating” tab

Replay Raw Data File

Display 
All Ch an nels

Extract Long Spikes

Save Spikes

Filter Raw Data

D isplay 
Extracted Spikes

Filter Raw Data

Display 
All Ch an nels
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Fig.4-3.9. Control panels for the “Export_for_propagation_analysis_spontaneous” workflow. “Filter” tab (left) and 
                

 
Filter 
Raw Data

Display All
Channels
(for filtered
 data)

Extract Long Spikes

   

    Save Spikes

 Display Extracted Spikes

  

 

“Detect beating” tab (right).
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4-3.3. Field potential duration analysis
    -Analysis for extracted long spikes’ waveforms with the “QT_analysis” workflow template-
      
 

1. Open the “QT_analysis” workflow template, and then the data file. 
(Refer to page 95)

2. Open the “Detect beating” tab and check the “Disable” box on the 
[Extract Long Spike] module.(Fig.4-3.10) Run Mobius with Green but-
ton, and then stop.

3. Select a SINGLE channel for analysis with the channel selector in the 
[Acquire MED64 Data] module. (The channel sector pops up when the 
box next to channels on the [Reply Raw Data File] module is clicked.)

Notice:

• It is technically possible to select more than single channel for 
analysis. However it is NOT recommended to do so because 
selecting more than 1 channel slows down data processing, and 
makes your analysis more difficult unless the signals are synchronized. 

• If you would like to analyze more than 1 channel simultaneously, copy the analysis workflow 
file and data file to another folder, and then replay and analyze using the copied workflow. 
(This is NOT possible for acquisition.)

4. Open the “Detect beating” tab. Uncheck the “Disable” button (Fig.4-3.12), and set thresholds.

How to set thresholds 

1)   The numbers for Thresholds and Pre/Post times can be changed
      by double-clicking and typing numbers directly on the chart.
      (Fig.4-3.12)

2)   Pre/Post times must be identical for all 64 channels. 
      Different numbers can be selected for thresholds.

3)   The number changed for threshold can be applied to all another
      channels by right-clicking the number and selecting Apply to All. 
      (Fig.4-3.12)

• “Disable” button: When this check box is checked, long 
spikes are NOT extracted. It is used mostly for acquisition.

Notice: 

• It is not recommended to set thresholds both for + and -. 
Select either one or detect long spikes.

• Set the thresholds as low as possible for negative signals  
(high for positive signals) so that other components of 
the signals are NOT extracted as spikes. (Fig.4-3.13)

Fig.4-3.10. Disable button.

Fig.4-3.11. Channel selector.

 
                      

Fig.4-3.12. Changing the 
 thresholds.

   Fig.4-3.13. Bad example for spike
   extracting. 



                                      Mobius Tutorial (SU-MED640): Cahper 4 - Mobius QT                                      103 

4-3. Replay and analysis of acquired spontaneous data

5. Replay data with Green button. The long spikes extracted are high-lighted in light green on the left 
chart of [Display Extracted Spikes] and waveforms of extracted long spikes are displayed on the 
right chart. (Fig.4-3.14)

How to modify the charts in the [Display Extracted Spikes] module

• [Trace] chart (left):

The time scale for amplitude can be changed by clicking and typing in 
the desired minimum and/or maximum values. (Fig.4-3.15).

The time duration can be changed in the “Duration” drop down menu. 
(Fig.4-3.16)

• [Extracted Spikes] chart (right):

The scale for amplitude and time can be changed by click-
ing and typing in the desired minimum and/or maximum 
values. (Fig.4-3.15)

• The scale can be adjusted automatically by clicking [Auto-
scale] button or double-clicking anywhere on the chart.

6. Open the “Measurement” tab by clicking the tab name. The extracted long 
spikes are filtered before they are sent to the [Extract Spike Measures] mod-
ule. In the default setting, the “Bessel low pass 9 pole with 1000 Hz” and 
“None” are selected. Modify the filter type and cut-off frequencies depending 
on your signals. (Fig. 4-13.17)

Fig. 4-3.14. Long spikes are extracted (high-lighted with light green color).

Fig. 4-3-15.

Figure. 3-3.11

Fig.4-3.16.

Fig.4-3.17.
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7. Set the waveform analysis parameters in the [Extract Spike Measures] module.

The "Time of Amplitude Max To Max" is the default setting. This measurement  type analyzes 
the time of amplitude maximum between the left-most 2 cursors and the right-most 2 cursors. 
(Fig.4-3.18) Set the cursor by left-clicking and dragging them.

8. In order to change the measurement type, click [Edit Measures] button, and then select different 
analysis (measurement) with the drop-down menu for the “Measure Type”. (Fig.4-3.18)

• Please refer to page 105 for detail about the [Extract Spike Measure] module.

9. Replay data with the Green button. When you are satisfied with your 
analysis parameters, save this as your analysis workflow. (Fig.4-3.19) 
The measurement chart can be saved as a “CSV” text file when the 
workflow is run with Green-Red button while checking the “Enable” 
check box for [Save Measure Data] module is checked. (Refer to section 
4-3.7. Data output on pages 116-118 for details.

• The “QT_analysis” workflow template includes the modules for beat 
frequency analysis. Please refer to section 4-3.4. Beat frequency 
analysis on pages 109-110 for details.

Time of Amplitude 
Max to Max

Fig.4-3.18. Definition of the “Time of Amplitude Max to Max” 
  (left) and how to select  the measurement type (right).
                        

Fig.4-3.19.

Fig.4-3.20. Field potential duration analysis. The time between peaks are measured with the “Time of Amplitude Max 
 to Max” protocol and graphed (middle-right). The numbers are shown on the [Display Results Table] module (bottom).
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Other available analysis (Measures) for analyzing field potential duration

Time of Crossing Horizontal Cursor 

•  Computes the “time” from the left-most vertical cursor (“cursor1”) to the first intersection of 
the extracted spikes with the horizontal cursor AFTER the right-most vertical cursor 
(“cursor2”). (Fig.4-3.21)

Time of Slope Crossing Horizontal Cursor 

• This measure uses four cursors as shown in Fig.4-3.22 - three vertical and one horizontal. It 
computes the “time” from the left-most vertical cursor (“cursor1”) to the intersection of the 
linear fit slope line computed on the data between the second and the third vertical cursor 
with the horizontal cursor. (“cursor2” and “cursor3”). (Fig.4-3.22)

Time of Crossing Horizontal Cursor

Fig.4-3.21.

Fig.4-3.22. 

Liner line

Time of Slope Crossing Horizontal Cursor
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[Extract Spike Measures] module

This module allows you to perform waveform analysis for extracted long spikes. Time, amplitude, slope, 
and area can be measured and graphed. 

1) Raw data chart

1. The raw data chart on the left shows the extracted long spikes’ waveforms. The cursors for the 
measurements are shifted by left-clicking and dragging.

2. You can zoom in on the Raw data chart by: 

1) left-clicking and dragging while pressing the shift button.

2) changing the maximum (and/or minimum) numbers for both X (time) 
and Y (amplitude) axis. Click, and then, type in the new value(s) for the 
maximum and/or minimum. (Fig.4-3.24)

•  The scale can be adjusted automatically by double clicking any-
where on this chart.

3. The cursor locations can be copied to all or specific channels by 
right-clicking and selecting the [Apply Cursors to All Channels] or 
[Copy Cursors]. Select [Apply Cursors to All Measures] to copy the 
cursor locations to all measures.(Fig.4-3.25)  

Selecting [Copy Data] allows you to copy the waveform data and 
paste to an excel worksheet.           

1      2                3      4        5            6                   7            8          9                      10    3) Input fields           
Fig.4-3-23. [Extract Spike Measures] module.

1) Raw data chart                              2) Measurement chart

Fig.4-3.24.

Fig.4-3.25.
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2) Measurement chart

The time course for the selected measurements is graphed here. Zoom 
in or out by changing the maximum (and/or minimum) values for the X 
and/or Y axis. Click and type in the new values directly.

Right-clicking anywhere in the chart and selecting [Copy Data] allows 
you to copy the measurement data and paste to an excel worksheet 
(Fig.4-3.25). Selecting [Capture Image] allows to copy the chart 
image.

3) Input fields for the [Extract Spike Measures] module

1. Channel No: Selects the channel for display. 

2. “Average” check box + “Traces” dropdown:
Check this box to average extracted spike waveforms. Set the number of traces to determine how 
many traces will be averaged (e.g. If 3 is input and the box is checked, every three traces (-1st, 
2nd, and 3rd / 2nd, 3rd, and 4th / 3rd, 4th, and 5th) are averaged and plotted.

3. “Capture” button:
Click the Capture button on three different waveforms 
to capture each of them on the screen. (Fig.4-3.27)  
Additional clicking will drop and replace the oldest cap-
ture with a new one. Right-click on the [Capture] but-
ton to expose a menu of options for clearing captured 
waveforms. Useful for comparing the waveforms in dif-
ferent phases.

4. "X-labels" checkbox:
Check this box to display the X-axis positions of the 
cursors in the left Raw data chart.

5. “Reset Cursors” button:
If zooming operations have caused the cursors in the left Raw data chart to move out-of-sight, click 
this button to bring them back into view.

6. “Probe” dropdown:
This input field will be fully enabled in future upgrade. 

7. “Sync Thresh % dropdown” + “Windows ms” dropdown:
This feature is helpful only when more than one channel is analyzed at once. (Selecting more than 
1 channel is NOT recommended in current version of Mobius.) You can detect long spikes and filter 
out unexpected noise by requiring that a certain percentage of active channels (“Sync Thres”) pro-
duce long spikes within a certain window of time (“Window”). It is useful to view the output of this 
panel in [Display Results Table] when adjusting these settings, because you can quickly see which 
channels are not producing synchronized responses, and deactivate them.

TimeOfAmplitudeMinToMax(ms)
148.05
161.65
156.1
162.9

156.75

Fig.4-3.26. Copy data.

Fig.4-3.27
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8. “Hide Phases” check box:
The phase bars (yellow bars with characters on the measurement chart) are hidden when this but-
ton is clicked.

9. “Autoscale Measures” check box: 
When this box is checked, the scale for the measurement chart is automatically adjusted. You can 
zoom in and out in the measurement chart by typing values in the X and Y axes' limits when the 
Autoscale button is NOT checked.

10. Edit Measures: Click this button to select or change the analysis (measurement) menu.

1) Select the analysis (measurements) you desire from the [Measure Type] box to change the default 
measures. (Fig.4-3.28)

2)  You can name the selected measures by double-clicking and typing the desired name directly into 
the [Custom name] box.

3)  To perform more than one analysis (Measure), click [Add Measures] button so another row on the 
table and new measurement chart appears. (It is NOT recommended to select more than 1 
measure during acquisition because it can slow down analysis significantly.)

4)  You can delete unnecessary measurements by right-clicking the [Custom Name], and selecting 
[Delete].

• Click [Measures Help] button for detailed information on measurements.

5)   The table shows the cursor values. Cursors can also be adjusted by changing numbers in this 
table.

6)  Click the [Hide] button to close the editor. 
3)

Fig.4-3.28. Edit Measures. 

                  

4)
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4-3.4. Beat frequency analysis

The [Compute Beats per Minute] and [Compute Interspike intervals] modules in the 
"Beat_frequency_analysis" workflow template are used.

1. Open the analysis workflow template and data file. (Refer to page 95)

2. Open the “Detect beating” tab and check the “Disable” box on the 
[Extract Long Spikes] module.(Fig.4-3.29) Run Mobius with Green 
button, and then stop.

3. Select the channels for analysis with the channel selector in the 
[Replay Raw Data File] module. (Channel selector pops up when the 
box next to “Channels” on the [Reply Raw Data File] module is clicked. 
(Fig.4-3.30)

4. Open the “Detect beating” tab, and uncheck the “Disable” button. Set 
the thresholds in the [Extract Long Spikes] module by following step 4 
in section 4-3.2. Field Potential duration analysis (page 102).

5. The [Compute Beats per Minute] module builds a cumulative 
record of beat frequency changes. The computations are made 
independently on all channels and displayed on the [Display 
Beats per Minute] control panel.

The default setting has 10 seconds selected for the Binning win-
dow size. Extracted long spikes are counted every 10 seconds. 
Selecting "Trace" instead of "Arbitrary (s)" means that spikes 
are counted for the whole trace.

6. The [Compute Interspike intervals] measures the time between 
each successive spike and creates a cumulative record of the 
changes. The computations are made independently on all chan-
nels and displayed on the [Display Interspike Intervals] module.

The “Average Channel ISI" function in the [Compute Interspike 
Intervals] module measures the average time between the two 
most recent spikes across all active channels.

7. Replay data with Green button. When you are satisfied with your analy-
sis parameters, save this as your analysis workflow. (by clicking [Work-
flow] > [Save As])(Fig. 4-3.33)

8. In order to save these charts as "CSV" text files, check the “Enable” box 
on the [Save Beats per Minute] (and/or [Save Interspike Intervals]), 
then replay data with GREEN-RED button. (Refer to section 4-3.7."Data 
output on pages 117-119).

Fig.4-3.29. Disable button.

Fig.4-3.30. Channel selector.

Fig.4-3.31. Compute Beats per  
Minute module.

Fig.4-3.32. Compute Interspike
Intervals module.

Fig.4-3.33.
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Fig.4-3.34. Analysis performed with the “Beat_frequency_analysis” workflow template. Beats (long spikes) are 
counted by every 10 seconds and displayed on the [Display Beats per MInute] module. (top-graph)
 

                         

Interspike intervals are measured and graphed in the [Display Interspike Intervals] module. (center graph)

                         
 The bottom graphs show long spikes that are extracted over time (high-lighted with light-green) (left) and each
extracted long spike (right).  
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4-3.5. Making a dose-response-curve

This section will walk you through making a dose-response curve with the field potential duration from 
the acquired data. The Mobius' [Compute Measure Averages] module computes averages and standard 
deviations of:
1)  waveform analysis selected at the [Extract Spike Measures].
2)  beat frequencies.
3)  interspike intervals.

Case1: How to make a dose-response-curve of the acquired data with phase bars 
             -Based on the instructions in section 4-2. Drug testing (page 92-93)-

1. Open the analysis workflow which was automatically made when you acquired the data. 
(Go to [Workflow] > [Open].) 

2. Add the [Compute Measure Averages] module to this analysis 
workflow.

1) Create a new tab by clicking [Layout] > [Add Tab] and typing
    the name for this tab. (Refer to Fig.4-3.35)

2) Open the new tab, and then open the “Mobius Editor” by clicking 
[Workflow] > [Edit]. (Fig.4-3.36, left figure) 

3)  Click the [Extract Spike Measures] on the left “Workflow” box, 
and then double-click the [Compute Measure Averages] on the 
right “Available task panels” box. Now you will see that 
[Compute Measure Averages] module shift to the left “Workflow” box and the control panel for this 
modules appears on the new tab. (Fig.4-3.36)

4) Click the [Compute Measure Averages] on the left "Workflow” box, and then double-click the [Save 
Measure Averages] on the right "Available task panels” box. The control panel for the [Save 
Measures Averages] module will be displayed on your screen. 

3. Set the analysis parameters according to the instructions in 4-3.2. Field potential duration analysis 
(pages 102-108).

Fig.4-3.35. Adding a new tab.

Fig.4-3.36. Mobius Editor was opened in a new tab and the [Extract Spike Measures] is clicked (left). 
          The [Compute Measures Averages] was double-clicked and shifted to the left “Workflow” box. The control
         panel for this module now appears (right).                                    
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4. Run Mobius with Green button to replay the data to the end. You will see the phase bars you set 
during your acquisition in the [Extract Spike Measures] module, and averages and standard devia-
tions in the [Compute Measures Average] control panel. (Refer to Fig.4-3.37)

5. The phase bars are shifted by clicking and dragging. The averages and standard deviations are 
recalculated once Mobius is run with Green or Green-Red button after changing the locations of 
phase bars.

6. In order to save the average chart, save it as your own analysis workflow first. ([Workflow] > [Save 
as]) Check the “Enable” check-box on the [Save Measure Averages] module, then run Mobius with 
the Green-Red button. (Refer to section 4-3.7. Data output on pages 116-118 for details.)

Fig.4-3.37. The results of “Time of Amplitude Max to Max” with phase bars in the [Extract Spike Measure] (top)
and the averages and standard deviations for each phase displayed in the [Compute Measure Averages] control
panel.



                                      Mobius Tutorial (SU-MED640): Cahper 4 - Mobius QT                                      113 

4-3. Replay and analysis of acquired spontaneous data

Case 2: How to make a dose-response-curve with acquired data using
             “QT_analysis” workflow template   -How to add phase bars-

The “QT_analysis” workflow template includes the [Compute Measures Average] and [Save Measure 
Averages] modules. It is not necessary to add those modules to this analysis workflow. However, phase 
bars need to be added.

1. Open the “QT_analysis” workflow template, and then open the data file. (Page 94-99)

2. Set the analysis parameters according to the instructions in the 4-3.2. Field potential duration anal-
ysis (page 102-108).

3. Open the “Measurement” tab, and then replay the data with the Green button. You will see the first 
phase, Baseline (yellow bar) is already at time 0.    

4. When the first phase is finished, pause Mobius 
with YELLOW button, and make a new phase. 

• Select [Annotators] > [Add New phase], 
then, type the name for the new phase. 
(Fig.4-3.38) 
Now you will see the new bar at the right 
chart of the [Extracted Spike Measures]. 
(Fig.4-3.39)

• Do NOT stop Mobius with Black button. 
You will not be able to add more phases. 

5. When the second phase finished, pause 
Mobius again and make a new phase.
*The location of the phase annotator (yellow 
bar) can be shifted later.

6. Replay the data to the end. Averages and 
standard deviations are computed and 
graphed for each phase (dose) in the Average 
tab. (Refer to Fig.4-3.37)

7. In order to save the average chart, save it as 
your own analysis workflow first. Check the 
“Enable” check-box on the [Save Measure 
Average] module, and run Mobius with 
Green-Red button. (Refer to section 4-3.7. 
Data output on pages 117-119 for detail.)

Input fields for [Compute Measure Averages] module

1. Channel: 
The channel to be displayed is selected here. Channels can NOT be changed while running an 
experiment.

2. Use last: 
If this box is checked, the selected (or typed) number of data points are used for computation. For 
example, if 10 is selected, average and standard deviation are measured for the last 10 data points 
in each phase.

Fig. 4-3.38.

Fig.4-3.39.
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4-3.6. Propagation analysis for spontaneous data

This section describes how to generate a propagation map (distribution of the peak times) using the 
“Export_ for_propagation_analysis_spontaneous” workflow template and excel. You will save the “time 
for the amplitude peak” as a “CSV” file using this workflow template, and then generate a propagation 
map using an excel file. The excel file (“Propagation_analysis_spontaneous”) is available from the Sup-
port page on the MED64 website. www. med64.com/Support.  

CAUTION:

•  All 64 channels must have signals for the excel file to work.                

1. Open the “Export_ for_propagation_ analysis_spontaneous” workflow template. (Refer to page 93.)

2. Open the data file, and replay the data by clicking the Green button. 
(Refer to section 4-3.1. Replaying acquired data on page 94)

3. When the peak points in the original raw data are not clear enough, modify the filter menu so that 
peak points are seen clearly.

4. Set the thresholds for the all channels. (Refer to page 102)

5. Replay data again to make sure you are satisfied with the new thresholds.

6. Make sure that “Enable storage” is checked and 
“Time stamps only” is selected in the [Save 
Spikes] module. (Fig.4-3.40)

7. Save it as your own analysis workflow by click-
ing [Workflow] > [Save as].

8. Click the Green-Red button so that the time 
stamps for the peaks are saved as a “CSV” file.

9. Open the “CSV” file with excel. (Fig.4-3.41 shows an example of the CSV file.) 

10. Open the excel file, "Propagation_analysis_spontaneous". This file consists of 4 sheets of [data], 
[analysis], [map_data], and [map]. You will copy some data to the [data] sheet. Propagation map 
will be displayed in the [map] sheet.

11. Copy the data in the “within_trace_time_ms” for channel 1-64 (marked with red in the Fig.4-3.41) 
on your “CSV” file, and paste them in the second row on the [data] sheet in the 
“Propagation_analysis_spontaneous” excel file.

Transpose Raw and Line.

12. A propagation map is generated in the “map” sheet of the “Propagation_analysis_spontaneous” 
excel file. (Fig.4-3.42)

Fig.4-3.40. [Save Spikes] module.



                                      Mobius Tutorial (SU-MED640): Cahper 4 - Mobius QT                                      115 

4-3. Replay and analysis of acquired spontaneous data

Fig.4-3.41. Top shows an example of data for saved time stamps displayed in excel. The data in the “Within_trace_ 
time_ms” (marked with red) is copied and pasted to the second row in the [data] sheet of “Propatation_analysis_
                      spontaneous” exel file.  
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Fig.4-3.42. A propagation map generated in the [map] sheet of the “Propagation_analysis spontaneous file.
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4-3.7. Data output

Mobius has several modules for data output of cardiomyocyte signals and their analysis. When the 
workflow is run by clicking Green-Red button with the check-boxes for the Save and/or Export modules 
checked, the data are saved and/or exported.

Channels for the Saving/Exporting are chosen with the channel selector in the [Replay Raw Data File] 
module. Channels shown with green will be enabled. File names for all export/saving modules can be 
modified by directly typing them into the Filename modifier box.

1. Export raw data

The [Export Raw Data] module is used. The raw data (waveform) is exported either as 1) Binary shorts 
(2 byte integer values), 2) Binary doubles (8 byte floating point values), or 3) ASCII text in “CSV” for-
mat.

File Form 20071201
Session S2010/10/04 14:31:18 +09

time_ms  ch20_mV  ch21_mV  ch22_mV  ch28_mV  ch29_mV  ch30_mV
0 -0.01953 -0.12818 -0.00244 -0.01831 0.06592 0.004883

0.05 -0.01831 -0.13062 -0.00732 -0.02441 0.063478 0.003662
0.1 -0.01587 -0.13916 -0.0061 -0.02075 0.070803 0.008545

0.15 -0.01831 -0.14039 -0.00488 -0.02441 0.06592 0.010987
0.2 -0.02075 -0.14161 -0.00366 -0.02319 0.069582 0.010987

0.25 -0.02441 -0.14527 -0.00732 -0.02686 0.059816 0
0.3 -0.01343 -0.13672 -0.00122 -0.02075 0.064699 0.001221

0.35 -0.01343 -0.13672 -0.00488 -0.01831 0.06592 0.003662
0.4 -0.02197 -0.14039 -0.01831 -0.02075 0.059816 0

0.45 -0.01465 -0.1355 -0.01221 -0.01831 0.068361 0.004883
0.5 -0.01465 -0.13672 -0.00855 -0.02319 0.064699 0

0.55 -0.02197 -0.15015 -0.01709 -0.02197 0.061037 0.001221
0.6 -0.00977 -0.1355 -0.00366 -0.01953 0.068361 0.008545

0.65 -0.01953 -0.14283 -0.01221 -0.02075 0.068361 0.003662
0.7 -0.01343 -0.13184 -0.01099 -0.02319 0.072024 0.004883

0.75 -0.01953 -0.14039 -0.01587 -0.01953 0.070803 0.007324
0.8 -0.00977 -0.13916 -0.01221 -0.02197 0.072024 0.007324

0.85 -0.01465 -0.13794 -0.01221 -0.02075 0.070803 0.003662
0.9 -0.01831 -0.13916 -0.01343 -0.02197 0.064699 0

0.95 -0.01831 -0.14161 -0.01587 -0.02197 0.063478 -0.00244
1 -0.02075 -0.14039 -0.01587 -0.02319 0.069582 0.003662

1.05 -0.01465 -0.13184 -0.01099 -0.01709 0.072024 0.007324
1.1 -0.01953 -0.13916 -0.01221 -0.02197 0.068361 0.003662

1.15 -0.01831 -0.13428 -0.01465 -0.02319 0.061037 -0.00488
1.2 -0.02319 -0.14649 -0.01831 -0.02075 0.061037 -0.00366

1.25 -0.01831 -0.14161 -0.00977 -0.01953 0.058596 -0.00122
1.3 -0.01587 -0.14527 -0.01099 -0.02319 0.056154 -0.00122

1.35 -0.01465 -0.13794 -0.00977 -0.01587 0.063478 0.007324
1.4 -0.01831 -0.1355 -0.01099 -0.02319 0.062258 0.007324

1.45 -0.01587 -0.13672 -0.01465 -0.02686 0.061037 -0.00122
1.5 -0.01831 -0.13672 -0.01343 -0.02197 0.061037 -0.00244

Fig.4-3.43. Example of raw data (waveforms) exported in ASCII format displayed in excel. Data for channel
20, 21, 22, 28, 29, and 30 were exported. 



118                                Mobius Tutorial (SU-MED640): Cahper 4 - Mobius QT 

4-3. Replay and analysis of acquired spontaneous data

2. Save the measurement chart

The [Save Measures Data] module is used. The 
measurement values in the [Extract Spike Mea-
sures] module are saved as a “CSV” formatted text 
file. 

    
          

Fig.4-3.44. Example of the “Time Of Amplitude 
Min to Max (ms)” for channel 29 saved as a “CSV” 
text file and displayed in excel.

      
3. Save the beat frequency data

The [Save Beats per Minute] module is used. The beat frequency data is saved as a “CSV” formatted 
text file.

File Format 20080210
Recording  2010/10/04 14:39:59 +09

TimeOfAmplitudeMinToMax(ms)
Trace#  Phase  Time (s)  ch29

1  Baseline 1.531 148.3
2  2.136 161.4
3  2.74 159.65
4  3.344 158.2
5  3.946 155.4
6  4.549 158.1
7  5.152 152.35
8  5.755 153.2
9  6.356 153.15

10  6.956 158.85
11  7.557 158.7
12  8.159 158.6
13  8.762 157.45
14  9.366 158.1

File Format 20071201
Session St 2010/10/04 14:39:59 +09

time_secs phase  ch21  ch22  ch29  ch30
  NC  NC  NC  NC

10 Baseline 102 102 102 102
20 96 96 96 96
30 102 102 108 102
40 102 102 96 102
50 102 102 102 102
60 102 102 96 102
70 96 96 102 96
80 102 102 102 102
90 102 102 102 102

100 96 96 96 96
110 102 102 102 102

430.641 0100nM E4031 102 102 102 102
440.641 96 96 96 96
450.641 96 96 96 96
460.641 96 96 96 96
470.641 96 96 96 96
480 641 96 96 96 96

Fig.4-3.45. Example of the beat 
frequency data for channel 21,22,
 29, and 30 saved as a “CSV”
 text file and displayed in excel.
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4. Save the inter-spike-interval data

The [Save interspike intervals] module is used. The inter-spike-interval data is saved as a “CSV format-
ted text file.

• Select SINGLE channel to save ISI data which signals are NOT synchronized for all channels. 
Otherwise, data will not be saved correctly.

5. Save the average chart

The [Save Measures Averages] module is used. The averages and standard deviations are saved as a 
“CSV” formatted text file. 

File Format 20071201
Session St 2010/10/04 14:39:59 +09

time_secs phase  ch21  ch22  ch29  ch30
  NC  NC  NC  NC

0.92355 Baseline 605.4 605.35 605.35 605.3
1.529 605.45 605.5 605.25 605.55

2.1335 604.5 604.5 604.6 604.45
2.7376 604.1 604.1 604.05 604.1

3.34125 603.65 603.7 603.8 603.75
3.944 602.75 602.75 602.5 602.75

4.5469 602.9 602.85 603.15 602.85
5.14945 602.55 602.55 602.55 602.5
5.7525 603.05 603 603.05 603.05
6.3536 601.1 601.1 601 601.05

6.95395 600.35 600.45 600.5 600.55
7.55505 601.1 601.1 600.75 601.1
8.1571 602.05 602 602.25 601.9

8.75975 602.65 602.6 602.7 602.6
9.3635 603.75 603.7 603.7 603.7

9.96775 604.25 604.35 604.25 604.4
10.57155 603.8 603.8 603.8 603.8
11.17725 605.7 605.65 605.7 605.7
11.78425 607 607 607 606.9
12.3899 605.65 605.65 605.65 605.7
12.9965 606.6 606.6 606.65 606.55

Fig.4-3.46. The inter-spike-interval data for channel 21, 22, 29, and 30 saved as a “CSV” file displayed in excel.

File Format Vers 20090613
Recording Date:  2010/10/04 14:39:59 +09

TimeOfAmplitudeMinToMax(ms)
Phase  ch29  +/-sd  
Baseline 160.553 4.877  
0100nM E4031 186.493 6.663  
1000nM E4031 212.575 7.272  

Fig. 4-3.47. The averages and standard 
deviations of the “Time of Amplitude Min to Max”
for channel 29 is saved as a “CSV file and 
displayed in excel.
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4-4. Recording of evoked myocardial signals 
The "Pacing_recording" workflow template is available for recording of myocardial signals with electrical 
stimulation (pacing).    

4-4.1. Overview of the “Pacing_recording” workflow template

The “Pacing_recording” workflow template consists of following modules located in the “Main” and “Pac-
ing measures” tabs.

Acquisition and stimulation parameters are set in the [Acquire MED64 Data w/Stim] module. Evoked 
signals are extracted and their amplitude, slope, time, and area are analyzed in the [Extract EP Mea-
sures] module. The raw data can be exported either as binary or ASCII data while the measurement 
chart is saved as a "CSV" formatted text file.

Tab Modules

Main Acquire MED64 Data w/Stim  / Display All Channels  / Export Raw Data

Pacing measures Extract EP Measures  / Save Meausres  Data

Fig.4-4.1. Module configuration for “Pacing_analysis” workflow temmplate.

“Main” tab

 “Pacing　
  measures”
  tab
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Opening the workflow template

1. Click [Workflow] > [New] > [From Template]. 

2. Select [SU-MED640_1280x1024] folder. Select [QT] > [Pacing_recording] folder, and then the 
“Pacing_recording” workflow template.

Fig. 4-4.2. Control panels for “Pacing_analysis” workflow template. ”Main” and “Pacing measures” tab.

Acquire MED64 Data
                         w/Stim

Export Raw Data 

Display All Channels

Extract EP Measures

Save Measures Data

Fig.4-4.3. Opening workflow template.
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4-4.2. Setting the acquisition and stimulation parameters

Acquisition and stimulation parameters are set in the [Acquire MED64 Data w/Stim] module.

Acquisition

1. # Traces:  Number of Traces (Sweeps).

2. Trace duration: Sampling (Recording) time for each trace.

3. Trace interval:
Interval between traces. (From the beginning of the first trace to the beginning of the next trace)
In the default setting (0.5 sec for Trace Duration / 1 sec for Trace interval), stimulation is applied 
every 1.0 second .

4. Range (V):  Signal range (Maximum input signals level).

5. Low cut freq (Hz):
High pass filter. Select from 0.1, 1.0, 10 and 100 Hz. If 1 is set, signals with frequencies lower than 
1 Hz are filtered out. The recommended filter setting for recording myocardial signals is 1.0 Hz.

6. Channels:
Select the channels for recording here. When the square box is clicked, the channel selector pops 
up. Green shows enabled channels.

7. Save raw data:
When Mobius is started with Green-Red button while the [Enable storage] is checked, the raw data 
is saved. Enter a descriptive file name of your choice.

(1)

(2)

(3)

(4) (5)

(6)

(7)

(8)
(9)

(10)

(10)

(11) (12) (14) (15)(13)

Fig.4-4.4. [Acquire MED64 Data w/Stim] module.

0.5 sec.

1 .0 sec
Recording

Stimulus pulse
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Stimulation 

Each Step is independent and can be programmed with different type of stimulation protocols. Enabled 
steps will be applied in the order (1 to 8) at the intervals set in the Trace interval.

8. Step enabled:
When the box to the left of [Step enabled] is checked, the Step becomes valid. The default settings 
have Step1 enabled and Steps 2-8 disabled (shown with # next to each Step). Step1 stimulation is 
applied at 1.0 second intervals. 

• For example, if both Step1 and Step 2 are enabled, the Step1 and Step 2 are applied alterna-
tively at 1 second intervals.

9. Stimulator selector and check box:
Select the MED64 amplifier’s built-in stimulator (F1, F2, V1, or V2) here. F1 corresponds to [INT. 
F1] on the MED64 integrated amplifier while V1 corresponds to [INT. V1]. Checking the box on the 
right of “Stimulator Enabled” activates the selected stimulator. The default settings have F1 enabled 
for Step 1. 

•  In order to stimulate through both stimulators simultaneously, enable both F1 and F2 stimula-
tor in Step 1.

10. Stimulus waveform editor:
Make your stimulus protocol here 
by selecting either [Const] or 
[Pulse] and typing in the desired 
[Length] and [Amplitude]. Refer to 
Fig.4-4.5 for a schematic represen-
tation of a stimulus protocol exam-
ple.

• The F1 and F2 channels do 
NOT support decimal num-
bers. The smallest current 
increment possible with the F 
stimulator is 1 A and 0.1 A 
with the V stimulator. 

• Do NOT select [Ramp] for the 
stimulation with the MED64. 
Only bi-phasic stimulation is recommended.        

11. Repeat pattern to trace end check box:
When this box is checked, the stimulus protocol will be repeated to the end of the trace. 

12. Reps selector:
The stimulus protocol set at the “Stimulus waveform editor” (10) is repeated the number of times 
set here. Useful for multiple pulse stimulation.

13. Stimulus current amplitude increment button: 

When the + button is clicked, the absolute value of the stimulus current amplitude for the [Pulse] is 
incremented by the value set in the left box. (14*) For example, if 2 is set in the box (14) and the 
+ button is clicked once, the stimulus amplitude will change to -12.00 A from -10.00 A. This is 
useful for changing the stimulus amplitude for multiple pulse stimulations with just one click. The 
absolute value of the stimulus amplitude can be decreased sequentially using the same procedure 
when - button is clicked.

 post stimulation time: 494.80 msec

 pre stimulation time: 5 msec

c

0.2 ms

                    

Fig.4-4.5. Example of stimulus protocol and its schematic diagram.
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14. See #13.

15. Auto inc check box:
When this box is checked, the stimulus current amplitude will automatically increase adding the 
value (in A) set in the left box (14) to each preceding stimulation pulse. This is useful for making 
I/O curves.

4-4.3. Execution button

The workflow template is run and stopped (paused) with the following execution buttons.
                     

4-4.4. Before starting your experiment

When Mobius is run with the Green or Green-Red button for the first time after turning on your 
MED64PC, it will take some time for signals to appear on the screen while signals stabilize and the iso-
electric baseline is zeroed at all 64 channels. Before you start your experiment, change the [Trace 
Interval] to around 1-2 seconds temporarily and run several traces for a few minutes (WITHOUT the 
stimulus cables plugged in) until the baselines at all 64 channels stabilize around 0 V. After this, stop 
Mobius and start your experiment.

  Stop                 Run WITHOUT        Run WITH        Pause
                       saving data             saving data

Fig.4-4.6. Execution buttons.

(top-right). The trace interval changed to 1 sec. (bottom-left)
Fig.4-4.7. Baseline traces before stabilizing (top-left) and stabilized 
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4-4.5. Recording of evoked cardiomyoyte signals

1. Set the acquisition and stimulation parameters in the [Acquire MED64 Data w/Stim] module
(Refer to section 4-4.2. Setting the acquisition and stimulation parameters on pages 122-124)

2. Run Mobius with the Green button.

3. Open the “Pacing measures” tab. Set the analysis parameters and cursors.
(Refer to section 4-5.2. Analysis of the evoked potential data on pages 129-131)

4. Save it as your recording workflow by clicking [Workflow] >[Save as].
(Fig.4-4.8)

5. Make sure the “Save raw data” in the [Acquire MED64 Data w/Stim] 
module is checked.

6. Run Mobius with the Green-Red button.

• Mobius will require you to save the workflow as your own if you try 
to start Mobius with the Green-Red button without having saved it 
already.

• The data file (.modat file) and the Analysis workflow (including all analysis module selected for 
the Recording workflow and [Replay Raw Data File] module) will be saved in the same folder. 
(Refer to pages 9-10)

 

Fig.4-4.8.
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4-5. Replay and analysis of acquired evoked potential data

A Mobius data file (.modat) can be opened and replayed with the [Replay Raw Data File] module. The 
evoked data can be analyzed using the [Extract EP Measures] module. You will design your Analysis 
workflow by combining those modules for replay and analysis of the acquired data. The quickest way to 
replay and analyze the evoked data is using the "Pacing_analysis" workflow template introduced in this 
chapter.

The Analysis workflow including the [Replay Raw Data File] and the analysis modules you selected for 
your recording will be automatically saved to the same directory when you run recording workflow with 
Green-Red button. Another quick way to replay and analyze the evoked data is to use the automatically 
generated analysis workflows.

4-5.1. Replaying acquired data

1. Open the analysis workflow template.

Click [Workflow] > [New] > [From Tem-
plate].

Select [SU-MED640_1280x1024] > [QT] > 
[Pacing_analysis] folders, then select the 
“Pacing_analysis” workflow template.  

In order to open your own analysis workflow, 
click [Workflow] > [Open]. Select the analy-
sis workflow file (.moflo file).                      

2. Click the box next to the “Filename” and select the .modat file. When the file name appears on the 
box as seen on the right figure of the Fig.4-5.2, the data is ready to be replayed by clicking Green 
button or Green-Red button.

3. When the Green button is clicked, the acquired data is just replayed. Clicking the Green-Red button 
execute the Exports or Saves which “Enable” check-box is checked.

Fig.4-5.1. Opening analysis workflow template.
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Input fields for the [Replay Raw Data File] module

1. Traces: Selects the trace(s) for processing.
2. Trace time: Selects the trace time for processing.
3. Channels: Selects the channels you would like to process. Click the box next to the “Channels” to 

open the channel selector. Green channels will be processed.
4. Delay: Set this value to a value greater than zero to insert a delay between data "blocks" sent out 

by this module. It is useful for delaying processing. 

2

Fig.4-5.2. Opening the Mobius data file (.modat file).

Fig.4-5.3. Replayed evoked potential data. 
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4-5.2. Analysis of evoked potential data

“Pacing_analysis” workflow template is available for the analysis of the evoked potential data.

Overview of the “Pacing_analysis” workflow template

The “Pacing_analysis” workflow template consists of following modules located in the “Main” and “Pac-
ing measures” tabs.

The replayed data is sent to the [Extract EP Mea-
sures] module, where evoked signals are 
extracted and their amplitude slope, time, and 
area are measured and graphed.

Phase measurement averages are computed and 
graphed accordingly when phase annotations are 
added. The raw data can be exported in either 
binary or ASCII (“CSV” format file). The mea-
surements and averages chart can be saved by a 
“CSV” formatted text file. 

Tab Modules

Main Replay Raw Data File / Display All Channels / Export Raw Data

Pacing measures
Extract EP Measures / Save Meausres Data  / Compute Measure Averages / Save
Measure Averages

Fig.4-5.4. Module configurations for “Pacing_analysis”
workflow template.

“Main” tab

“Pacing measures” tab

Replay Raw Data File

Display All Channels

Extract EP Measures         Save Measures 

Export Raw Data

Compute Measure Averages

Save 
Measure
Averages

Fig.4-5.5. Control panels for the “Pacing_analysis” workflow template. “Main” tab (left) and “Pacing measures”
tab (right). 

                                                                Data
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Waveform analysis of evoked cardiomyocyte signals

The [Extract EP Measures] module extracts the evoked signals and performs a variety of waveform 
analyses. Amplitude, slope, area, and time of the extracted waveforms are measured and graphed. The 
extracted evoked potential waveforms are displayed at the left chart and the timecourse of the selected 
measurements is graphed in the right chart.

1) Raw data chart

1. The raw data chart on the left shows the extracted evoked responses waveforms. The cursors for 
the measurements are shifted by left-clicking and dragging.

2.You can zoom in on the raw data chart by: 

1) left-clicking and dragging while pressing the shift button.

2) changing the maximum (and/or minimum) numbers for both X 
(time) and Y (amplitude) axes. Double-click, then, type in the new 
value(s) for the maximum and/or minimum. (Fig.4-5.7)

• Double-click anywhere on the chart to return to the original axis 
range.

3. The cursor locations can be copied to all or specific chan-
nels by right-clicking and selecting [Apply Cursors to All 
Channels] or [Copy Cursors]. Select [Apply Cursors to all 
Measures] to copy the cursor locations to all measures. 
(Fig. 4-5.8)  

Selecting [Copy Data] allows you to copy the measure-
ment data to an excel worksheet.

        

   

2) Measurement Chart1). Raw Data Chart

  

Fig.4-5.6. [Extract EP Measures] module.

  1                 2                3         4             5        6             7                      8                                             9

Fig. 4-5.7

Fig.4-5.8
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2) Measurement chart

The time course for the selected measurements is graphed 
here. Zoom in or out by changing the maximum (and/or mini-
mum) values for the X and/or Y axis. Click and type in the new 
number directly.

Right-clicking anywhere in the chart and selecting [Copy Data] 
allows you to copy the measurement data to an excel worksheet 
(Fig.4-5.9) while selecting [Capture Image] allows you to copy 
the chart images. 

 

3) Input Fields

1. Channel No:
Selects the channel(s) for display by scrolling or typing the num-
bers directly. These can be changed even during recording or 
replaying.

When the channel selector is right-clicked and [Select] is clicked, 
the Channel selector box appears. The channels of interest are 
selected using this channel selector as well. (Fig 4-5.10) 
Selecting more than 1 channel is useful for running the 4-head 
system by allowing users to save charts to 4 different “CSV” files 
by preparations.

2. Step Filter: 
The Step to be analyzed is selected here. Step1 is selected in the default settings.  
• In order to analyze Conductor data, ALL must be selected.

3. Shift (ms):
For analysis of paired pulse experiments. When a number greater than 0 is selected here, the cur-
sors and chart for the 2nd pulse appear.

4. X Labels:
The time point at which the waveform crosses the cursor is displayed on the Raw data chart when 
this check box is clicked.

5. Reset: Resets the shifted cursors to the original positions.

6. Hide phases:
The phase bar (yellow bars with characters on the measurement chart) is hidden when this button 
is clicked. Please refer to section 4-3.5. Making a dose-response-curve on pages 110-112 for 
details.

7. Autoscale:
The scale for the measurement chart is automatically adjusted when this check-box is checked. You 
can zoom in and out in the measurement chart by typing numbers directly into the maximal values 
for the X and Y axes when the Autoscale button is NOT checked.

8. Average:
When this box is checked, the averaged measurements are computed and graphed. Set the number 
of traces to be averaged with the selector right to the check box. (e.g. if 2 is input and the box is 
checked, every two traces -e.g. 1st and 2nd, 2nd and 3d, 3rd and 4th- are averaged and graphed.)

     Fig.4-5.9. Copying data.

TimeOfAmplitudeMaximum(ms)
25.62833787
25.62833787
25.62833787
25.62833787

Fig. 4-5.10.
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9. Edit Measures: Click this button to select or change the measurement (analysis) menu.

1)  Select the analysis (measurement) you desire from the [Measure Type] box to change the default 
measures.

2)  You can name the selected measures by double-clicking and typing directly into the [Custom 
Name] box.

3)  In order to have more measures, click [Add Measures] button so another row on the table and a 
new measurement chart appears.

4)  You can delete unnecessary measurements by right-clicking the Custom name, and selecting 
[Delete].

• Click [Measures Help] button for detailed information on measurements.

5) Click the Hide button to close this editor.

Measurement chart output

After you select the analysis parameters, you probably will want to create a measurement chart. When 
the check box for [Save Measures Data] is checked and the analysis workflow is run with Green-Red 
button, the chart is saved as a "CSV" text file. 

The output channels can be chosen with the channel selector in the [Replay Raw Data File] module. 
Channels in green will be enabled. Please refer to section 4-3.7. Data output on page 116 for details.

4)

    

Fig.4-5.11.

1)

3)                           2)

File Format 20080210
Recording  2004/3/27 14:29:00 +09

TimeOfAmplitudeMaximum(ms)
Trace#  Phase  Time (s)  ch1  ch2  ch3  ch4  ch5  ch6  ch7

1  Baseline 0 16.95 14.05 12.7 13.1 16.05 18.7 22.2
2  16 17.1 14.25 12.9 13.3 16.15 19 22.5
3  32 17.15 14.3 12.9 13.25 16.2 18.95 22.5
4  48 17.3 14.4 13 13.4 16.25 19 22.5
5  64 17.25 14.45 13.05 13.35 16.2 18.95 22.45
6  80 17.15 14.35 13.05 13.4 16.2 18.9 22.4
7  96 17 14.2 12.95 13.2 16.1 18.7 22.15
8  112 16.85 14.15 12.75 13.2 15.9 18.55 22
9  128 16.75 14.05 12.7 13 15.8 18.4 21.75

10  144 16.75 14.05 12.7 13.05 15.75 18.35 21.75

Fig. 4-5.12. Example of Time of Amplitude Maximum (ms) saved as a “CSV” text file displayed in excel.
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Propagation analysis for evoked potential data

This section describes how to generate a propagation map (distribution of the peak time) of evoked 
potential data using the “Pacing_analysis” workflow template and excel. You will save the “time for the 
amplitude peak” as a “CSV” file using this workflow template, and then generate a propagation map 
using an excel file. Please download the excel file “Propagation_analysis_evoked_potential” from the 
website. www.med64.com/resources

1. Open the “Pacing_analysis” workflow template. Replay the data by clicking the Green button, and 
then stop.

2. "Time Of Amplitude Maximum"  is selected as default. This protocol will measure the time from the 
first cursor to the maximum amplitude between the two right-most cursors. (Fig.4-5.13)

• If you would like to generate a potential map based on the minimum peak, change the menu 
to "Time Of Amplitude Minimum".

3. Set the first cursor to the 0 timepoint, and 2nd and 3rd cursors so that the maximum (or minimum) 
amplitude is between these two cursors. Set the cursors accordingly for all 64 channels. 

• The cursor locations can be copied to all or specific channels by right-clicking and selecting the 
[Apply Cursors to All Channels] or [Copy Cursors]. (Refer to page 129)

4. Check the “Enable” check box in the [Save Measures Data]. 
(Fig.4-5.14)

5. Save it as your own workflow. ([Workflow] > [Save as])

6. Run Mobius with Green-Red button. The amplitude maximum 
time data will be saved as a “CSV” file.

7. Open the “CSV” file with excel. (The top chart in the Fig.4-5.14 shows the “CSV” data opened with 
excel.)

Fig.4-5.13.

Time of Amplitude 
Maximum

Fig.4-5.14.
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8. Open the excel file, "Propagation_analysis_evoked_potential. The file consists of 4 sheets of [data], 
[analysis], [map_data], and [map]. After inputting the data in the [data] sheet, the data will be 
displayed as a propagation map in the [map] sheet.

9. Copy the data for channels 1-64 for a specific trace in your "CSV" file (top chart in the Fig.4-5.15), 
and paste it into the 2nd line in the [data] sheet of the "Propagation_analysis_evoked_potential" 
file . (bottom chart in the Fig.4-5.15).

File Form 2E+07
Recordin  2004/3/27 14:29:00 +09

TimeOfAmplitudeMaximum(ms)
Trace#  Phase  Time (s) ch1  ch2  ch3  ch4  ch5  ch6  ch7  ch8  ch9  ch10

1  Baseline 0 16.95 14.05 12.7 13.1 16.05 18.7 22.2 24.95 13.9 11.1
2  16 17.1 14.25 12.9 13.3 16.15 19 22.5 25.15 14.05 11.2

3  32 17.15 14.3 12.9 13.25 16.2 18.95 22.5 25.2 14.15 11.3

4  48 17.3 14.4 13 13.4 16.25 19 22.5 25.2 14.3 11.45

5  64 17.25 14.45 13.05 13.35 16.2 18.95 22.45 25.1 14.35 11.45

 ch59  ch60  ch61  ch62  ch63  ch64
22.2 21.55 23 25.15 26.95 30.55
22.5 21.9 23.45 25.6 27.6 31.1

23.1 22.25 23.75 25.95 27.8 31.4

22.85 22.35 23.85 26 27.95 31.45

24.25 23.4 25.05 27.05 28.9 32.5

CH1 CH2 CH3 CH4 CH5 CH6 CH7 CH8 CH9 CH10 CH11

17.15 14.3 12.9 13.25 16.2 18.95 22.5 25.2 14.15 11.3 8.8

CH59 CH60 CH61 CH62 CH63 CH64

23.1 22.25 23.75 25.95 27.8 31.4

Fig. 4-5.15. The “Time of Amplitude Maximum” saved as a  “csv” file using the “Pacing_analysis” workflow template 
(top). The Time of amplitude maximum for trace 3 is coped and pasted to the 2nd line on the [map] sheet in the 
“Propagation_analysis_evoked_potential” file.
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10.  Change the “value in the stimulation channel” to the “pre-stimulation time (the time of the stimu-
lus artifact onset)”. (Refer to Fig.4-5.14)

11. A propagation map is generated on the [map] sheet in the  
“Propagation_analysis_evoked_potential” excel file. (Fig.4-5.15)

CH16 CH17 CH18 CH19 CH20 CH21 CH22 CH23 CH24 CH25 CH26 CH27 CH28 CH29 CH30

24.7 13.55 9 5 8.55 13.25 16.8 20.3 24.05 13.6 10.1 5 10.05 13.45 17.05

Fig.4-5.14. The values for stimulation channels (19 and 27) were changed to the pre-stimulation time (5 msec).

(top). 

1

2

3

4

5

6

7

8

1 2 3 4 5 6 7 8

25-30
20-25
15-20
10-15
5-10

Fig.4-5.15. Propagation map.
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